
COMMENTS:
This file is organized in a three level hierarchy.    The topmost level is the Index level, which 
includes the lists of help topics for Commands, Tools, Symbols and Libraries, Procedures and 
Hints.    The next level includes all help topics that are accessed directly from the Index level,
such as the File Menu window, or the Line Tool Menu.    The third level is accessed from the 
second, such as help for the File New topic.

HOW TO GENERATE A .HLP FILE:
1. Open and edit windraw.doc.    It's format must match that of the Window's Help Compiler, 

HC.EXE.    Footnotes before topic titles describe the "address" or handle of the topic,    the 
title of the topic, its browse sequence, etc.    Single and double underlined and hidden text 
describe hypertexting and the address of the topic to display or jump to.    The bounds of 
the topic are the footnote denoted title, and the first HARD page break after the title.    

2. Save windraw.doc, then Save it As windraw.rtf, IN RTF FORMAT !!    It is the .rtf file that is
used by the Help Compiler.    The glossary terms are in terms.rtf, and the help for keys and 
Windows is in keys.rtf.    These three .rtf files are used to create the file windraw.hlp.    You 
can make references between .rtf files without any special work.    The compiler finds the 
references if they exist in any of the files.    

3. The file windraw.hpj is the project file, which is like a makefile.    It details the first index 
handle, the title for the help window, the .rtf files and bitmaps used in the compilation.    All
bitmap files must be listed here, and the files must exist where the compiler can find them.

4. The Help Compiler is run using the batch file makehelp.bat.    The command line is "hc 
windraw".    The only other stuff the batch file does is copy the help file up a directory, and 
delete a temporary file called windraw.ph.    Not deleting the file causes a compilation 
warning.    



FIRST LEVEL OF HELP TOPICS:



WinDraw     Help Index 1 of 2

Click on a topic for more information:

Getting Started
Hints and Shortcuts

Commands
File Menu Edit Menu
Layout Menu Style Menu
Window Menu

Tools
Using the Tool Palette
Selector Tool
Line Tool
Text Tool
Rectangle and Rounded Rectangle Tools
Ellipse Tool
Arc and Pie Tools
Closed Polygon and Open Polygon Tools
Bezier Curve Tool
Closed Scribble and Open Scribble Tools
Control Point Tool

About Help for WinDraw

Use the Browse buttons to see the rest of the Index,
and the Search button to see a list of Help Topics.



WinDraw     Help Index 2 of 2

Drawing Procedures 
Moving, Resizing and Copying Objects
Editing Text Objects
Using Keystrokes to Execute Menu Commands
Drawing Lines at 45 Degree Increments
Drawing Squares and Circles
Selecting Objects That Overlap
Working With Groups of Objects
Copying an Object's Attributes
Converting Between Polygons and Bezier Curves
Exchanging Graphics with Other Programs
Using WinDraw with Paintbrush
Working With the Multiple-Document Interface

Symbols and Libraries
Overview of Symbols and Libraries
Creating Symbols in a Library
Using Symbols in a Drawing
Searching for a Symbol

Other Topics
Glossary
Using Windows Keys

Use the Browse buttons to see the rest of the Index,
and the Search button to see a list of Help Topics.



The Index contains a list of all Help topics available for WinDraw.    For information on how to 
use Help, press F1 or choose Using Help from the Help menu.



SECOND LEVEL OF HELP TOPICS:



Getting Started

WinDraw runs in a window within the Windows environment.    When WinDraw is first started,
the Title bar at the top of the window shows the title WinDraw - [Drawing 1], and the 
standard window controls appear at the top and along the edges of the window.    The Menu 
bar shows the names of the drop-down menus, through which you can execute WinDraw 
commands.    You can click on each menu title to view the contents of the menu.    The ruler 
can be seen on the left and top edges of the drawing surface, and the Tool Palette is along 
the left edge of the window.    When you want to end WinDraw, click on the Control menu box
in the upper left corner, and then click on the Close command.      Another way to end 
WinDraw is to execute the File Exit... command on the File menu.    You will always be 
prompted to save any unsaved drawings before WinDraw ends.    

Refer to your Windows documentation to learn about moving and resizing windows, and 
using window controls.    You should be familiar with Windows terms such as click, double 
click, drag, clipboard, etc.    The Glossary section defines these and other often used 
terms.    

There are no installation or configuration procedures to be performed before using WinDraw;
you can begin drawing immediately.    WinDraw is structured as if you were working with a 
sheet of paper, using different tools to draw various shapes.    When you want to draw a 
specific type of shape (also called an object), you can select the corresponding tool from the 
Tool Palette with the mouse, and use that tool to draw objects of that type.    

The tool at the top of the Tool Palette is the Selector Tool  , which is used to move and 
reformat existing objects.    When it is being used, the mouse pointer appears as an 
arrowhead 

 , and objects that have already been drawn can be moved, deleted, resized, rotated, 
flipped or copied.    Most of the tools on the Tool Palette are drawing tools, which are used 
only to create new objects.    When a drawing tool is selected, the mouse pointer appears as 
a crosshair: 

.    Proceeding down the Tool Palette, you will see tools that let you draw lines and enter 
text, tools that draw regular rectangles and rectangles with rounded corners, and a tool to 
draw ellipses (and circles).    Below that are tools that are used to draw arc and pie shapes, 
tools to draw closed and open polygons, and a tool to draw curves.    Next are tools to draw 
open and closed scribbles, which are shapes that you create as if drawing freehand.    Finally 
there is the Control Point Tool, which has a special application for polygons and curves.    

After reading the drawing example below, you might find these Help Topics useful as an 
overview for drawing: Using the Tool Palette, Selector Tool and Moving, Resizing and Copying
Objects.    There are also Help Topics that describe each of the tools on the Tool Palette, and 
their use.    The Help Topic Hints and Shortcuts contains tips for using WinDraw quickly and 
effectively.    

A Drawing Example:
The following example will describe the steps in drawing a rectangle using WinDraw, and 
then reformatting the rectangle to alter its appearance in the drawing:    

Start by moving the mouse pointer over the Rectangle Tool on the Tool Palette.    The mouse 
pointer will change to a hand with an outstretched index finger when it is over the Tool 
Palette.    Click on the Rectangle Tool to select it, and the Rectangle Tool icon will be 
highlighted.    Now move the mouse pointer back onto the drawing surface near the upper 



left corner of the drawing.    Note that the shape of the mouse pointer has changed to a 
crosshair.    Press the mouse button and hold it down while you drag the mouse pointer down
and to the right, away from the starting point, until the rectangle shown is roughly the size 
and shape that you want.    Release the mouse button, and the rectangle will be drawn.    

The new rectangle has eight small black squares around its perimeter.    These are grab 
handles, and they indicate that the rectangle is selected.    When an object is selected, you 
can use the Selector Tool to move, resize and reformat the object.    Move the mouse pointer 
to the Tool Palette and click on the Selector Tool, then move the mouse pointer back into the 
drawing until it is inside the rectangle.    Hold the mouse button down while you drag the 
rectangle to a new position in the drawing.    When you release the mouse button, the 
rectangle will stay in its new position.    

Now move the mouse pointer until it is over the square black grab handle at the lower right 
corner of the rectangle.    When the mouse pointer changes to a double headed arrow, press 
the mouse button and drag the grab handle to change the size of the rectangle. When you 
release the mouse button, the rectangle will keep its new size.    

Finally, click on the Layout menu on the Menu bar, then click on the Rotate Left command,
and the rectangle will rotate counterclockwise by 90 degrees.    The Layout and Style 
menus contain commands to reformat objects that are selected.    Now, if you click the 
mouse button when the mouse pointer is outside the rectangle, it will become deselected, 
and will stay as it is until it is again selected and moved or reformatted.    

Other drawing tools work in a fashion similar to the Rectangle Tool, but some, like text 
objects and scribbles, have special features or procedures.    You can refer to the 
corresponding Help Topics for information on the use of each drawing tool, and on advanced 
drawing procedures.    



Hints and Shortcuts

Some procedures that can help you work more efficiently are listed below.    These tips are 
not meant to be thorough descriptions of the features that are presented, but are quick 
reminders of how you can save time while using WinDraw.    These procedures are presented 
in greater detail throughout the on-line Help system.    

General Information
*    Use WinDraw's multiple document interface to open several drawing and library windows 

at once, and cut and paste objects between them.    Any window can be minimized to an 
icon within WinDraw, or expanded to fill the entire screen.    You can make any open 
drawing the active drawing by selecting it from the list of open files on the Window menu. 

*    All menu commands can be executed with the keystroke sequences that correspond to 
the underlined letters on the menu items, such as Alt+S and then F to execute the Style 
Fill command.    

*    To move graphics from WinDraw into other programs, use the Edit Copy command to 
copy all selected objects to the Windows clipboard.    Then start the other program, and 
paste in the WinDraw graphics.    You can also use the File Export... command to translate
WinDraw graphics into a foreign file format, which can be read by another program.    

Drawing Tips
*    When a drawing tool is selected from the Tool Palette, click on the right mouse button to 

pick the Selector Tool from the Tool Palette.    

*    Select multiple objects by dragging the Selector Tool across them, or by holding down the
Shift key while clicking on the individual objects.    Clicking on one of several selected 
objects while holding down the Shift key will deselect that object only, leaving the others 
selected.    

*    To make a duplicate of one or more selected objects, press the key sequence Ctrl+D.    
This will copy the selected objects to the clipboard and paste them into your drawing in a 
single operation.    

*    When you want to resize one or more selected objects, but you want to maintain the 
relationship between their height and width, hold down the Shift key while dragging one 
of the corner grab handles.    

*    To select an object that is beneath another object, continue to click in a region where both
objects overlap until the object that you want is selected.    

*    To avoid deselecting an object and selecting another that overlaps it, hold down the Ctrl 
key, and the selected object will remain selected when you click on it, or move or resize it, 
instead of selecting an overlapping object.    

*    When one object hides another object, select the hidden object and use the Layout 
Bring to Front command to move it to the top layer of the drawing.    You can also use the
Layout Send to Back command to move an object to the bottom layer of the drawing.    

*    If you have part of a drawing that you need to use multiple times, draw it in a library 
symbol, and use the Edit Paste Special command to paste it into drawings.    When the 
Symbol (Linked) option is used during the Paste Special operation,    the copies can all be
updated automatically by modifying the original drawing in the library symbol.    



*    If you need very small, detailed objects, draw the shape pixel by pixel in Paintbrush and 
paste it into your WinDraw drawing as a bitmap.    You can also use Paintbrush to create 
shading effects or filled regions that can then be pasted into a WinDraw drawing.    

*    When several objects that you have drawn need to stay together, select them all and 
create a Group by executing the Layout Group command.    

*    Turn off the drawing grid to move objects by small amounts.    The drawing grid constrains
objects to land on one sixteenth inch boundaries.    

*    To pick up the fill pattern, color, line thickness, font characteristics, etc. of an existing 
object, select the object whose attributes you want to copy.    A newly drawn object will 
have the characteristics of the previously selected object.    

*    To add a fill pattern to an irregular area of a drawing, draw a closed polygon whose shape 
matches the outline of the area, and fill the polygon.    

*    To replace an object with the contents of the clipboard, select it before pasting in the 
clipboard contents.    To avoid replacing any selected objects, deselect them before pasting 
from the clipboard.    

Drawing shortcuts for specific objects
*    To draw exact squares, circles or circular arcs and pies, hold down the Shift key while 

drawing with the Rectangle, Rounded Rectangle, Ellipse, Arc or Pie Tools.    

*    To draw lines that are either vertical, horizontal or at a 45 degree angle, hold down the 
Shift key while drawing the line.    You can change existing lines to be vertical, horizontal 
or at a 45 degree angle by holding down the Shift key while moving one end of the line.    

*    To change the fill pattern on a closed shape (except for closed polygons), double click on 
it to display the Fill Color dialog box.    

*    To change the line ending style of a line, double click on it to display the Line Endings 
dialog box..    

*    To edit a text object, double click on it to put it into edit mode.    

*    To change a closed or open polygon, or a Bezier curve into any of the other two object 
types, double click on it to display the Polygon Type dialog box.        

*    To avoid a jagged appearance for closed and open scribbles, turn the drawing grid off 
while drawing with the Closed and Open Scribble Tools. 



File Menu

The File menu includes commands that let you open and save new or existing drawing files 
or library files, and print the active drawing or library file.    You can also exit WinDraw 
through the file menu.

For more information, click on a File menu command name.

New... Opens a new drawing or library file
Open... Opens an existing drawing or library file
Save Saves the active file to disk but does not close its window
Save As... Saves the active file to disk with a new file name
Close... Saves the active file to disk and closes its window
Export... Translates the active file into a non-WinDraw file format
Printer Setup... Activates the Printer Setup dialog box
Print Preview... Displays an entire drawing as it will appear on a printed page
Print... Prints the currently active file
Exit... Ends WinDraw, after prompting to save all unsaved work



Edit Menu

The Edit menu includes commands that let you move selected objects to and from the 
clipboard, delete selected objects, and undo a previous command or procedure.    The Edit 
Paste Special command is used to import a symbol from a library into a drawing.    

For more information, click on a Edit menu command name.

Undo Cancels the last command or operation
Cut Removes the selected objects from the drawing and places 

them on the clipboard
Copy Copies the selected objects to the clipboard while leaving the 

original objects in the drawing
Paste Pastes the contents of the clipboard into the active drawing
Clear Deletes the selected objects from the current drawing
Paste Special... Pastes a symbol from a library into a drawing



Layout Menu

The Layout menu includes commands that let you turn the ruler along drawing borders on or
off, and turn the visible grid and drawing grid on or off for a drawing.    You can also use 
commands on the Layout menu to change the order in which overlapping objects stack from 
back to front, rotate or flip all selected objects, and group or ungroup the selected objects 
together.

For more information, click on a Layout menu command name.

Hide/Show Ruler Toggles the ruler between displayed and hidden
Hide/Show Visible Grid Toggles the visible grid between displayed and hidden
Drawing Grid Enables and disables the drawing grid
Bring to Front, Send to Back Changes the vertical stacking order of overlapping 

objects
Rotate Left, Rotate Right Rotates the selected objects
Flip Horizontal, Flip Vertical Flips the orientation of selected objects
Group, Ungroup Creates or dissolves groups of objects



Style Menu

The Style menu includes commands that let you change the fill pattern on objects, change 
line styles and line endings, and change fonts and character formatting on text objects.

For more information, select a Style menu command name.

Fill... Changes the fill pattern and color for an object
Lines... Changes the outline style and color for an object
Endings... Changes line ending shapes
Font... Changes character font and point size
Character Formats Changes character formats such as Bold, Underline, etc.



Window Menu

The Window menu includes commands that let you arrange or close the drawing and library 
windows that are open, arrange the windows within WinDraw that are iconized, or switch to 
(activate) a drawing or library window.    

For more information, click on a Window menu command name.

Tile Arranges open windows in a tiled pattern
Cascade arranges open windows in a cascaded pattern
Arrange Icons Arranges icons at the bottom of the WinDraw window
Close All Closes all windows and icons within WinDraw
List of Open Files Lists all open files; click on one to activate it



Using the Tool Palette

The Tool Palette is the vertical menu of drawing Tools at the left of the WinDraw workplace.    
To use one of the Tools, move the mouse pointer until it is over the Tool that you want.    If 
the Tool you want is not visible, use the vertical scroll bar to the right of the Tool Palette to 
scroll the Tool Palette up or down until the Tool you want is visible.    When the mouse pointer
is over a Tool on the Palette, the shape of the pointer changes to a hand with the index 
finger outstretched.    Click on the Tool that you want to use to select it.    Once a Tool is 
selected, its icon on the Tool Palette is highlighted, and it is available for use until you select 
another Tool.    

Move the mouse pointer back onto the drawing surface near the area where you want the 
new object to be drawn. When any of the drawing tools is selected, the mouse pointer will 
appear as a crosshair: .    Press the mouse button down, and drag the mouse away from 
the starting point, until the object is roughly the size and shape that you want.    When the 
new object is close to what you want, release the mouse button.    A new object will have 
been drawn, and will still be selected.    If you want to draw a second object of the same 
type, repeat the drawing operation.    The first object you drew will be unaffected.    You do 
not need to deselect the first object before drawing the second.    See the Help Topics for the 
individual drawing tools for more information on how to draw the exact shape you want.    

If you want to move or resize the object you have just drawn, choose the Selector Tool from 
the Tool Palette and use it to drag the object, or one of its grab handles to a new position.    



Selector Tool

The Selector Tool is used to select one or more objects in a drawing, to move objects, to 
resize objects, and to change the shape of objects.    The Selector Tool does not draw any 
object or shape itself, but is only used to modify other objects.    

When the Selector Tool is being used, the mouse pointer appears as an arrowhead  , and 
any object in the drawing can be selected by clicking on it.    When any object other than a 
line is selected, it appears surrounded by a rectangle which consists of eight black grab 
handles.    This indicates that the object is selected, and is called the selected rectangle.    
When a line is selected, it is not surrounded by a selected rectangle, but has control points 
showing at its endpoints.    Normally, when an object is selected, any other object that was 
already selected becomes deselected.    If the Shift key is held down when an object is 
selected, previously selected objects will remain selected.    Clicking on one of several 
selected objects while holding down the Shift key will deselect that object only, leaving the 
others selected.    

To select multiple objects, press the mouse button outside of the objects and drag the 
mouse pointer diagonally across the objects that you want to select.    A dashed rectangle 
will appear as you drag the pointer, and any object that is partially or completely inside the 
dashed rectangle will be selected when you release the mouse button.    Once selected, the 
set of objects can be moved or resized collectively.    

To select an object which is beneath another object, continue to click in a region where both 
objects overlap until the object that you want is selected.    To avoid deselecting an object 
and selecting another that overlaps it, hold down the Ctrl key, and the selected object will 
remain selected when you click on it, or move or resize it, instead of selecting an 
overlapping object.    

Once selected, any object's shape and size can be modified by dragging one of the object's 
grab handles, or it can be moved by dragging the object itself.    Some objects, such as 
Bezier curves and polygons, have control points along their shapes, in addition to their grab 
handles.    By dragging a control point with the Selector Tool, the shape of these objects can 
be changed.    

Hint: As a short cut, the Selector Tool can be selected from the Tool Palette by pressing the 
right mouse button, instead of moving the mouse pointer over to the Tool Palette and 
selecting it directly.    The right mouse button is the rightmost button on either a two button 
or a three button mouse.    



Line Tool

The Line Tool is used to create straight lines in a drawing.    A line can be drawn using a 
variety of line widths and colors, and the line can be solid, or made from dashes or dots, or 
from a dash-dot or dash-dot-dot pattern.    These line attributes are accessed from the Style 
Lines...  command.    One of several shapes can be selected as line endings using the Style 
Endings... command. 

If you want to draw lines that will always be perfectly vertical or horizontal, or at a 45 degree
angle to horizontal, hold down the Shift key while you draw the line.    When the Shift key is
held down while drawing a line, the line will only appear on 45 degree boundaries (including 
vertical and horizontal).    As you drag one end of the line around in the drawing, it will snap 
into each of the allowed orientations.    

If an existing line is not on a 45 degree boundary and you want it to be so, select it, and then
hold down the Shift key while dragging one end of the line to the orientation that you want. 
The line will snap to a vertical, horizontal, or a 45 degree orientation.    

Lines that consist of multiple connected line segments, that is lines with bends, are referred 
to as Open Polygons in WinDraw, and are described in the Closed Polygon and Open Polygon 
Tools section.



Text Tool

The Text Tool is used to place text objects in a drawing.    To use it, first choose the Text Tool 
from the Tool Palette and move the mouse pointer into the drawing where you want the text 
placed.    Press the mouse button and drag the pointer until a rectangle is created that is 
large enough to hold the text that you want.    Release the mouse button when the rectangle 
is drawn, and the rectangle will appear with grab handles and an insertion point cursor 
where text can be entered.    The text object is now in edit mode. 

Enter the text that you want into the rectangle.    All standard cut, copy and paste features 
work inside the text object.    Individual words can be selected by double clicking on them, or
a block of text can be selected by dragging the mouse pointer across the text.    Text can also
be copied to or pasted from other text objects or other Windows programs by using the 
clipboard.    For more details on how to edit a text object see the Help Topic Editing Text 
Objects.

Word wrapping will happen automatically when the text reaches the right-hand edge of the 
selected rectangle.    The Style Font... command can be used to change the font or point size 
of the text.    When you are finished entering or editing the text in the text object, click 
outside the text object to end edit mode for the object.    

To move or resize an existing text object, use the Selector Tool and click on the text object.    
The selected rectangle with grab handles will appear around the text object, and the object 
can be moved by dragging it, or resized by dragging one of its grab handles.    The text 
inside the selected rectangle will always fill up the rectangle starting at the upper left 
corner, and will word wrap automatically at the right hand edge of the rectangle.    

To edit an existing text object, use the Selector Tool and double click on it.    The text object 
will become selected, and an insertion point cursor will appear, indicating that the text 
object is in edit mode.    When you are finished editing the text, click outside the text object 
to end edit mode for the object.    

Note that when a text object is selected with a single click from the Selector Tool, it appears 
with grab handles for moving or resizing.    When a text object is double clicked with the 
Selector Tool it becomes selected, but is also in edit mode, meaning that the text inside the 
rectangle can be changed.    



Rectangle and Rounded Rectangle Tools

The Rectangle and Rounded Rectangle Tools are used to create rectangles with sharp or 
rounded corners in a drawing.    To use them, select either tool from the Tool Palette, and 
move the mouse pointer into the drawing where you want the rectangle to be placed.    Press
the mouse button and drag the pointer until a rectangle of the size and shape that you want 
appears.    If you hold the Shift key down while drawing a rectangle or a rounded rectangle, 
a square object will be drawn.    When you release the mouse button, the rectangle will be 
drawn, and will remain selected.    

The Selector Tool can be used to move or resize the rectangle. You can choose the Selector 
Tool by clicking the right mouse button.    When you double click on a rectangle or a rounded 
rectangle with the Selector Tool, a dialog box is presented that allows you to modify the fill 
pattern in the rectangle.    This dialog box can also be accessed by using the Style Fill... 
command while the rectangle is selected.    The line thickness and line style of the rectangle 
can be modified by using the Style Lines... command while the rectangle is selected. 



Ellipse Tool

The Ellipse Tool is used to create ellipses and circles in a drawing.    Note that a circle is one 
form of an ellipse, so one tool is used to draw both shapes.    To use the Ellipse Tool, select it 
from the Tool Palette, and move the mouse pointer into the drawing where you want the 
ellipse or circle to be placed.    Press the mouse button and drag the pointer until an ellipse 
of the size and shape that you want appears.    If you hold the Shift key down while drawing 
an ellipse, a circle will be drawn.    When you release the mouse button, the ellipse will be 
drawn, and will remain selected.    

The Selector Tool can be used to move or resize the ellipse. You can choose the Selector Tool 
by clicking the right mouse button.    When you double click on an ellipse with the Selector 
Tool, a dialog box is presented that allows you to modify the fill pattern in the ellipse.    This 
dialog box can also be accessed by using the Style Fill... command while the ellipse is 
selected.    The line thickness and line style of the ellipse can be modified by using the Style 
Lines... command while the ellipse is selected. 



Arc and Pie Tools

The Arc Tool is used to create arcs of a circle or an ellipse, and the Pie Tool is used to create 
pie shaped segments of a circle or an ellipse.    An arc appears as a single curved line that is 
part of the outline of a circle or an ellipse, while a pie appears as a circle or an ellipse with a 
triangular section removed from it.    The use of the Arc and Pie Tools are identical, so both 
are described together.    

To use the Arc or Pie Tool, select one from the Tool Palette, and move the mouse pointer into 
the drawing where you want the arc or pie to be placed.    Press the mouse button and drag 
the pointer until an ellipse (or circle) appears which is the size and shape of the arc or pie 
that you want.    If you hold the Shift key down while drawing the ellipse, a circle will be 
drawn.    

When you release the mouse button after drawing the ellipse, a line will appear from the 
center of the ellipse out to the mouse pointer.    This is the first of two radius lines that will 
define what portion of the ellipse will be used for the arc or pie.    Move the mouse pointer 
around the circumference of the ellipse until the radius line is at the point along the ellipse 
where you want one end of the arc or pie to be, and click the mouse button to set the 
position of the first radius line.    Now move the pointer around the ellipse again until the 
second radius line is at the point on the ellipse where you want the other end of the arc or 
pie to be.    When you click the mouse button again, the position of the second radius line will
be set, the arc or pie will be drawn, and will remain selected.    

The Selector Tool can be used to move or resize the arc or pie, or to change the points on 
the ellipse where the arc or pie begins and ends.    You can choose the Selector Tool by 
clicking the right mouse button.    When an arc or pie is selected, it is surrounded by its 
selected rectangle with grab handles, and it has two radius lines, which end in control 
points.    The grab handles can be dragged to change the size and shape of an arc or pie, and
the control points can be dragged to rotate the radius lines, changing the points on the 
ellipse where the arc or pie begins and ends.

When you double click on a pie (but not on an arc) with the Selector Tool, a dialog box is 
presented that allows you to modify the fill pattern in the pie.    This dialog box can also be 
accessed by using the Style Fill... command while the pie is selected.    The line thickness and
line style of the arc or pie can be modified by using the Style Lines... command while the arc
or pie is selected. 



Closed Polygon and Open Polygon Tools

The Closed Polygon and Open Polygon Tools are used to create closed and open polygons in 
a drawing.    A polygon is a shape made up of individual connecting line segments.    A closed
polygon has the same starting and ending point and can have a fill pattern, while an open 
polygon has separate starting and ending points, and cannot be filled.    

To use the Closed Polygon and Open Polygon Tools, select one from the Tool Palette, and 
move the mouse pointer into the drawing where you want the polygon to be placed.    Press 
the mouse button and drag the pointer to create the first line segment of the polygon.    The 
first segment will be a line from the point where the mouse button was pressed to the point 
where it was released.    Continue to move the mouse pointer to create subsequent 
segments of the polygon.    Each time the mouse button is clicked, a new segment will be 
drawn.    When all the segments have been drawn, double click the mouse button, and the 
polygon will be complete and will remain selected.    If the Closed Polygon Tool was being 
used, a line will be drawn from the ending point of the polygon back to its starting point, 
closing the polygon.    

The Selector Tool can be used to move or resize a polygon, or to move the endpoints of any 
line segment of the polygon. You can choose the Selector Tool by clicking the right mouse 
button.    When a polygon is selected, it is surrounded by a rectangle with grab handles, and 
it has control points at the end of each line segment in the polygon.    Grab handles and 
control points both appear as black squares; grab handles are slightly larger than control 
points.    The grab handles can be dragged to change the size and shape of the polygon as a 
whole, and the control points can be dragged to move the endpoints of the individual line 
segments.

When you double click on a closed or open polygon with the Selector Tool, a dialog box is 
presented that allows you to change the polygon to either an open polygon, a closed 
polygon or a Bezier curve.    You can use this dialog box to change any of these three object 
types to any of the other object types.    

The fill pattern of a closed polygon can be changed by using the Style Fill... command while 
the polygon is selected.    The line thickness and line style of an open or closed polygon can 
be modified by using the Style Lines... command while the polygon is selected. 



Bezier Curve Tool

The Bezier Curve Tool is used to create Bezier curves in a drawing.    A Bezier curve is a 
simple or compound curve whose individual segments are defined by the line segments of a 
polygon.    When a Bezier curve is being created or modified, a polygon which defines the 
boundaries of the curve is shown.    After editing, the Bezier curve is drawn which most 
closely matches that polygon.

To use the Bezier Curve Tool, select it from the Tool Palette, and move the mouse pointer into
the drawing where you want the Bezier curve to be placed.    Press the mouse button and 
drag the pointer to create a line segment as if you were drawing a polygon.    The first 
segment will be a line from the point where the mouse button was pressed to the point 
where it was released.    Continue to move the mouse pointer, and create one polygon 
segment for each segment that you want the Bezier curve to have.    Each time the mouse 
button is clicked, a new segment will be drawn.    When all the segments have been drawn, 
double click the mouse button, and the Bezier curve will be drawn and will remain selected.   

The Bezier curve that is drawn will begin and end at the starting and ending points of the 
polygon that defines it.    Each time an intermediate line segment is made in the defining 
polygon, the curvature of the Bezier curve is "pulled" toward the control point where two 
adjacent line segments meet. 

The Selector Tool can be used to move or resize a Bezier curve, or to change the curvature 
of any segment of the Bezier curve. You can choose the Selector Tool by clicking the right 
mouse button.    When a Bezier curve is selected, it is surrounded by a rectangle with grab 
handles, and it has control points that show the ends of each line segment in the polygon 
that defines the Bezier curve.    Grab handles and control points both appear as black 
squares.    Control points are slightly smaller than grab handles.    The grab handles can be 
dragged to change the size and shape of the Bezier curve as a whole, and the control points 
can be dragged to change the curvature of individual segments of the Bezier curve.

When you double click on a Bezier curve with the Selector Tool, a dialog box is presented 
that allows you to change the Bezier curve to either an open polygon, a closed polygon or a 
Bezier curve.    You can use this dialog box to change any of these three object types to any 
of the other object types.    

The line thickness and line style of a Bezier curve can be modified by using the Style Lines... 
command while the Bezier curve is selected. 



Closed Scribble and Open Scribble Tools

The Closed Scribble and Open Scribble Tools are used to create closed and open scribbles in 
a drawing.    A scribble is a tracing of the path over which you have moved the mouse 
pointer while using the Scribble Tool.    You can think of a scribble as the mark which would 
be left by a pen if you were to move it around on a sheet of paper without lifting it.    A closed
scribble has the same starting and ending point and can have a fill pattern, while an open 
scribble has separate starting and ending points, and cannot be filled.    

To use the Closed Scribble and Open Scribble Tools, select one from the Tool Palette, and 
move the mouse pointer into the drawing where you want the scribble to be placed.    
Holding the mouse button down will make the Scribble Tool leave a mark along the path 
where you drag the mouse pointer.    When you release the mouse button, the Scribble Tool 
stops marking.    The scribble will be complete and will remain selected.    If the Closed 
Scribble Tool was being used, a line will be drawn from the ending point of the scribble back 
to its starting point, closing the scribble.    

The Selector Tool can be used to move or resize a scribble, but the path drawn by either 
Scribble Tool cannot be altered once it has been drawn.    A scribble can be moved, resized, 
flipped or rotated as desired.    You can choose the Selector Tool by clicking the right mouse 
button.    

When you double click on a closed scribble with the Selector Tool, a dialog box is presented 
that allows you to modify the fill pattern in the scribble.    This dialog box can also be 
accessed by using the Style Fill... command while the scribble is selected.    The line 
thickness and line style of the scribble can be modified by using the Style Lines... command 
while the scribble is selected. 

Hint: Scribbles may appear jagged if drawn while the drawing grid is turned on.    This is 
because the Scribble Tools will draw small line segments that end on grid points when the 
drawing grid is turned on.    You can avoid this jagged appearance by turning off the drawing 
grid while drawing scribbles.    Once drawn, a scribble can be placed back on the drawing 
grid, if desired.    



Control Point Tool

The Control Point Tool is used to change the number of control points used in an existing 
open polygon, closed polygon or Bezier curve.    It can be used to add or delete a control 
point to any of those three object types.    Control points appear as squares at the joints of 
polygons and Bezier curves.    A control point is slightly smaller than a grab handle.    To use 
the Control Point Tool, first select the open or closed polygon or Bezier curve that you want 
to modify, using the Selector Tool.    Next, select the Control Point Tool from the Tool Palette.   
The mouse pointer will appear as an arrowhead when the Control Point Tool is selected: .   

To delete a control point from a polygon or Bezier curve, place the mouse pointer over the 
control point that you want to delete, and click the mouse button.    Once the control point is 
deleted, the open or closed polygon, or the polygon which defines the Bezier curve, will be 
redrawn as if the control point never existed.    Using this process, an open polygon which 
originally consisted of four line segments can be reduced to just three line segments.    

To add a control point to a polygon or Bezier curve, place the Control Point Tool pointer over 
any spot inside the selected rectangle that defines the object, and click the mouse button.    
A new control point will appear at that position.    
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HELP FOR SYMBOLS:



Overview of Symbols and Libraries

Libraries are similar to drawings in that all of the drawing tools can be used to create and 
modify objects.    Unlike a drawing window, a library window can hold multiple drawings at 
once.    Within a library, each drawing is called a symbol, and has special properties and 
capabilities associated with it.    Symbols and libraries exist to make it easier to draw an 
object or group of objects repeatedly in one or more drawings, and to modify the resulting 
object or objects everywhere they are used, without having to change each object 
individually.    

Suppose you need a drawing of a house, and you need to use it multiple times in different 
drawings.    You can use a combination of rectangles, lines, polygons and curves to draw the 
house in a drawing.    Now you can use the standard cut, copy and paste features of WinDraw
to place copies of the house into various drawings.    If you need to change the size of the 
front door on all of the houses later, you must make all of the changes by hand, in one 
drawing at a time.    

An easier method would be to draw the house as a symbol in a library.    Once you have 
copied the house to the clipboard as a symbol from a library, you can use the Edit Paste 
Special... command to paste the house symbol into drawings.    When you execute the Edit 
Paste Special... command, you have three options for pasting the symbol into a drawing, 
presented to you in the Paste Special dialog box.    

If you choose the Symbol (No Link) option, the house will be pasted into your drawing as a 
single item, as if it were a group of objects.    You can move and resize the copy of the 
symbol in your drawing as a single object, but you cannot modify the individual objects that 
the copy of the symbol comprises.    

If you choose the Symbol (Linked) option for the Edit Paste Special... command, the 
symbol will again be pasted in as a single object.    In this case, however, any changes that 
are made to the symbol in the original library file will automatically be reflected in every 
drawing window where a copy of the symbol has been used.    Using this feature, if you have 
pasted the house symbol into multiple drawings and need to change the size of the door on 
the house, you need only make the change in the original symbol, and every linked copy of 
the symbol will be updated. 

If you choose the Separate Objects option for the Edit Paste Special... command, the 
symbol will be pasted into a drawing as individual lines, rectangles, etc., just as if you had 
used the Edit Copy and Edit Paste commands.    

You can create as many libraries as you want, with multiple symbols in each library.    The 
control buttons on a library window will let you perform these functions with symbols: scroll 
through all of the symbols in the library; start a new symbol; delete all objects from the 
current symbol; copy the current symbol to the clipboard; search for a symbol based on its 
properties; and assign properties to the current symbol.    The Help Topics Creating Symbols 
in a Library and Using Symbols in a Drawing describe the creation and use of symbols in 
detail.    



Creating Symbols in a Library

You can use the    File New... command to create a new library file, and the File Open... 
command to open an existing library file.    Library files end with the file name suffix .WDL.    
When you are creating a symbol in a library, all of the drawing tools from the Tool Palette 
work exactly as they do when making a drawing.    All object attributes, such as fill patterns 
and text fonts, and all formatting commands such as flips and rotates can be used to create 
a symbol.    You can think of a symbol as one of several drawings within a single library file.    

You can display all of the symbols in a library in turn by clicking on the Prev and Next 
buttons at the top of the library window.    When you are looking at the first symbol in a 
library the Prev button will be disabled, and the Next button will be disabled when you are 
looking at the last symbol in a library.    

To begin creating a new symbol in a library, click on the New button.    The symbol that was 
previously displayed will be hidden, and a new symbol is created, ready to be drawn in.    
When a new symbol is created, the other symbols in the library (the ones you can't see) are 
unaffected, but they are not saved to disk.    The entire library of symbols is saved to disk 
when the File Save, File Save As..., File Close... or Window Close All commands are executed. 
The symbols you create will be placed in the library in the order that you create them, with 
the first symbol displayed when you open the library file.    You can display all of the symbols 
by clicking on the Prev and Next buttons.    You can use the symbol properties (described 
below) to name or number the symbols if you want.    

To delete all the objects you've drawn in the current symbol and start over, click on the 
Clear button.    Clicking on the Clear button will only affect the currently displayed symbol in
the library.    When you want to copy the current symbol onto the clipboard so that you can 
use the symbol in drawings or in other symbols, click on the Copy button.    The symbol will 
be copied to the clipboard, and the contents of the symbol itself will be unaffected.    To use 
all of the properties of a symbol, use the Edit Paste Special... command (instead of the Edit 
Paste command) to paste the symbol into a drawing.    The Paste Special... command on 
the Edit menu is only enabled when a symbol is on the clipboard.    

When you click on the Prop... button, a dialog box will be presented that will allow you to 
enter a description of the currently displayed symbol.    You do not need to enter any 
properties before you use a symbol, but doing so may help you find a symbol in a large 
library later.    You can enter any text that you like to describe each symbol.    Clicking on the 
Search... button will display a dialog box that will let you search for text in all of the symbol 
descriptions that you have entered.      For more information on symbol properties see the 
Help Topic Searching for a Symbol.    



Using Symbols in a Drawing

When you want to use a library symbol in a drawing, you can copy the symbol to the 
clipboard and paste it into the drawing.    It is important to remember that WinDraw uses the 
clipboard to copy and paste symbols, just like all other Windows programs.    If any cut or 
copy operation is performed in WinDraw or in any other Windows program, a symbol that 
had been on the clipboard will be overwritten.    

Use the Prev or Next button to find the symbol that you want to use in the library.    When 
the desired symbol is displayed in the library, click on the Copy button to copy the symbol 
to the clipboard.    Now open or make active the drawing where you want to use the symbol, 
and execute the Edit Paste Special... command.    A dialog box titled Paste Special is 
displayed, which will give you three options for pasting the symbol into a drawing.    Choose 
either the Symbol (No Link), Symbol (Linked), or Separate Objects option, and click on 
the OK button to perform the paste.    If you click on the Cancel button, the paste operation 
will be cancelled.    Although you can use the Edit Copy and Edit Paste commands to copy 
and paste individual objects in symbols, you must use the Copy button and the Edit Paste 
Special... command to utilize the special features of symbols.    

If you chose the Symbol (No Link) option, the symbol will be pasted into your drawing as a 
single item, as if it were a group of objects.    You can move and resize the symbol in your 
drawing as a single object, but you cannot modify the individual elements that the symbol 
comprises.    

If you chose the Symbol (Linked) option from the Paste Special dialog box, the symbol 
will again be pasted in as a single object.    In this case, however, any changes you make to 
the original symbol back in the library window will automatically be reflected in every 
drawing window where a copy of the symbol has been used.    Using the Symbol (Linked) 
option, if you have used the symbol multiple times and need to change some aspect of the 
symbol, you need only make the change in the original library symbol, and every linked copy
of the symbol will be updated automatically. 

If you chose the Separate Objects option for the Edit Paste Special... command, the 
symbol will be pasted into a drawing as individual lines, rectangles, etc.    If either the 
Symbol (No Link) or the Separate Objects option was chosen during the paste, later 
changes made to the original symbol will not be reflected where a copy of the symbol has 
been used.    The automatic updating feature is only present when using the Symbol 
(Linked) option during the Edit Paste Special... command.    

Special Considerations for Linked Symbols
When a linked copy of a symbol is used in a drawing, the link back to the original symbol is 
based on the file name of the library that contains the symbol.    If you use a linked copy of a 
symbol in a drawing, and then change the name of the library file that holds the original 
symbol, the copy of the symbol in the drawing file will not be able to establish its link back 
to the original symbol, since the library file name will have changed.    

Therefore, if you create a new library file, draw symbols in it, and use copies of the symbols 
in drawings, you should always save or close the library file before you save or close any of
the drawings that hold copies of symbols from the library.    Before you save a new library file
for the first time, WinDraw assigns a default name to the file, such as "Library4".    If you 
close a drawing file that contains copies of symbols from a new library, the copies will be 
linked to the library file based on the library's default file name.    If you later save the library
file and don't use the default file name, the copies of the linked symbols in the drawing file 
will not find the library with the expected file name.



Linked copies of symbols will only be updated when both the library file that contains the 
original symbol, and the drawing file that contains the copy of the symbol are open in the 
WinDraw workplace.    All linked copies of symbols are updated automatically when both the 
original library file and the files containing the copies are open.    A symbol can be copied as 
many times as desired.    

A Drawing Example Using Symbols
Included with WinDraw is a demonstration library file named LIBDEMO.WDL.    You can use it 
to learn about symbol libraries, and how to use them in drawings.    To start, open the file 
LIBDEMO.WDL by executing the File Open... command in WinDraw.    You will also need to 
have an empty drawing window open to paste symbols into.    

LIBDEMO.WDL contains three symbols, each of which consists of a simple geometric shape 
and a text object that describes the symbol.    You can look at all of the symbols by clicking 
on the Prev and Next buttons at the top of the library window.    In this example, you will 
use the Edit Paste Special... command to paste each of the symbols into a drawing, and 
then examine how the copies of the symbols change when the original symbols are 
changed.    

Click on the Prev and Next buttons until symbol #1 containing the red circle is displayed.    
Click on the Copy button to copy the entire symbol to the clipboard.    You do not need to 
select any object before copying the symbol.    Now make the drawing window the active 
window, and execute the Edit Paste Special... command.    Select the Symbol (No Link) 
option from the dialog box that is displayed during the paste.    

Now go back to the library window and click on the Next button to display symbol #2, and 
click on the Copy button to copy it to the clipboard.    Return to the drawing window and use 
Edit Paste Special... to paste it into the drawing next to the copy of symbol #1, but this 
time choose the Symbol (Linked) option during the paste.    Repeat this procedure to paste 
symbol #3 into the drawing, but select the Separate Objects option when pasting it into 
the drawing.    You should now have copies of all three symbols side by side in the drawing 
window.    

Notice that when you click on the copies of symbol #1 or symbol #2 in the drawing window, 
the entire symbol is selected, and the geometric shape and text object cannot be selected or
manipulated as separate objects.    The copy of symbol #3 is not actually a symbol at all, but
is a separate triangle (closed polygon) and a text object, each of which can be selected and 
modified as desired.    The Separate Objects option copies individual objects, just like Edit 
Copy and Edit Paste commands.    

Next, you will modify the original symbols in the library window, and see how the copies in 
the drawing window change.    Display symbol #1 in the library window and double click on 
the circle.    A dialog box will be displayed that will let you change the fill pattern and color 
for the circle.    Change the color of the fill pattern, and click on the OK button.    Look at the 
copy of symbol #1 in the drawing file, and you will see that the color of the circle has not 
changed.    The Symbol (No Link) option will copy an entire symbol from a library as a 
single object, but copies of the symbol will not change when the original symbol changes, 
since the copy is not linked to the original symbol.    

Now display symbol #2 in the library window by clicking on the Next button, and double 
click on the blue square to change its color.    When you have chosen a new color for the 
square in the library symbol, look at the copy of symbol #2 in the drawing window.    The 
copy has the same new color as the original in the library.    The Symbol (Linked) option will
copy an entire symbol as a single object, and all copies of the symbol will change 
automatically to reflect any changes to the original symbol.    You can add, modify or delete 



objects in the original symbol, and all changes will appear in copies of the symbol.    You can 
also embed symbols into other symbols if you want to.    Linked symbols can be very useful 
when you need to use a drawing or a set of objects repeatedly, and need to change all 
copies at once.    

Finally, go back to the library window and change the color of the triangle in symbol #3.    
The copy of symbol #3 in the drawing window will not change, since it was pasted in as 
separate objects, not as a symbol.    

When you close LIBDEMO.WDL, you will be asked if you want to save the changes to the file. 
If you select Yes, your color changes will be saved.    If you select No, the file will still contain
the original colors for the objects.    



Searching for a Symbol

Symbols drawn in libraries can have properties assigned to them, which can be used to 
search for an individual symbol in a library.    The properties for the currently displayed 
symbol can be entered and modified when the Prop... button on the library is clicked on.    A
dialog box titled Symbol Properties is displayed, where text can be entered into the text 
entry box labeled Description:.    

You can describe the symbol with any text that makes sense to you.    The text you enter in 
the Description: field can be used later as the basis of a search for a specific symbol.    The 
Read Only check box on the Symbol Properties dialog box lets you protect the symbol 
from accidental modification.    When a symbol's Read Only check box is checked, the 
objects drawn in the symbol cannot be modified.    You can use the Read Only feature to 
protect completed symbols.    Once the symbol's properties are correct, click on the OK 
button, or click on the Cancel button to cancel your entry.    The symbol properties can be 
changed again at any time.    

You can search for a symbol in a library by searching for text that you have entered in the 
Symbol Properties dialog box.    When you click on the Search... button, the Library 
Search dialog box is displayed.    In the text entry field labeled Search For: you can enter a 
few characters, a word or a phrase that matches the text you previously entered as a 
symbol property.    You can enter as many or as few words or characters as you like for the 
search.    You do not need to enter whole words, and you do not need to enter the entire text 
that you used to describe the symbol in the Symbol Properties dialog box.    You can begin 
a search for a symbol regardless of what symbol is currently displayed.    

A straightforward approach to symbol description and searching is to enter several individual
words that describe the symbol in the Description: field of the Symbol Properties dialog 
box.    When using the Library Search dialog box, enter one of those words as a basis for 
the search, and click on the Find button.    For example, if you have created a symbol which 
is a drawing of a house, you might enter the words house, home and building in the 
Description: field.    When entering text to search for the symbol later, you could enter any 
of the three words you used as a description, or even parts of them, such as ho, build, or 
even uilding.    You need not remember entire phrases, or even entire words that you used 
as a description when you search for a symbol in a library.    

The search will begin with the currently displayed symbol, and will proceed through the 
library.    The first symbol found whose description matches the search text will be displayed. 
The Library Search dialog box will continue to be displayed, and you can use the same text
to continue the search (just click on the Find button again), enter new search text, or click 
on the Cancel button to end the search.    



HELP FOR DRAWING PROCEDURES:



Moving, Resizing and Copying Objects

Any object in a drawing can be moved, resized or copied by using the Selector Tool.    The 
Selector Tool can be chosen from the Tool Palette by clicking on it, or as a short cut, can be 
chosen by clicking the right mouse button.    An object must be selected before you can 
move, resize or copy it.    This is done by clicking on the object with the Selector Tool.    

When an object is selected, it appears surrounded by a rectangle that consists of eight black
grab handles.    This indicates that the object is selected, and is called the selected 
rectangle.    If more than one object is selected at once, the grab handles of the individual 
objects are gray, and a selected rectangle that encompasses all of the selected objects is 
shown, with black grab handles that are larger than normal.    For moving, resizing and 
copying operations, this group of selected objects will act as though it were a single object.

To move an object, first select it, then drag it with the mouse to the location in the drawing 
where you want it to be.    When you drag the object, you must press the mouse button while
the mouse pointer is inside the selected rectangle, but is not over one of the grab handles 
that make up the selected rectangle. 

To resize an object, select it and drag one of its grab handles inward or outward until the 
object's dashed selected rectangle is the size that you want.    If you drag one of the grab 
handles in the middle of the top, bottom or sides of the selected rectangle, you can change 
the height or width of the object.    If you drag a grab handle on a corner of the selected 
rectangle, you can change both the height and width of the object at once. 

You may want to resize an object without changing the proportion of its width to its height.    
The relationship of an object's width to its height is know as its aspect ratio.    To resize an 
object while keeping its aspect ratio the same, hold down the Shift key while dragging one 
of the grab handles on any corner of the selected rectangle.    The object will become 
proportionally larger or smaller.    

To copy an object, first select it, then execute the Edit Copy command, either via the Edit 
menu, or with the keystroke shortcut Ctrl+Ins.    This will make a copy of the selected object
and place the copy on the clipboard.    Now deselect the original object by clicking the mouse
while the mouse pointer is outside of any object.    Any object that is selected when a paste 
from the clipboard is performed will be deleted and overwritten by the object being pasted 
from the clipboard.    If you inadvertently delete an object while pasting in a new one, 
execute the Edit Undo command to undo the paste operation.    

When no objects are selected, execute the Edit Paste command to paste the object from the 
clipboard into your drawing.    The shortcut keystroke sequence for pasting is Shift+Ins.    
The copy of the original object will appear in the center of your drawing, and will be selected
so that you can move it to the part of the drawing where you want it to be.    The copy is 
identical to the original object, but it can be moved and modified independently, and will 
behave just as if you had drawn the object yourself.    If you want to quickly duplicate one or 
more objects, select the objects you want to copy, and press the key sequence Ctrl+D.    
This will copy the selected object(s) to the clipboard and paste them into your drawing in a 
single step.    



Editing Text Objects

The Text Tool places text objects in a drawing by creating a rectangle to hold the text.    
When a text object is first created, it is immediately in edit mode and is ready to have text 
entered into it.    When the text is correct, click outside the text object with the mouse, and 
you can create a new text object, or select another tool from the Tool Palette.    

All objects (lines, rectangles, polygons, etc.) in WinDraw can be selected with the Selector 
Tool and then modified, moved or resized.    Text objects can also be moved or resized when 
they are selected, but in order to change the text inside a text object, it must be placed in 
edit mode.    Like any other object, when a text object is selected with a single click from the 
Selector Tool, its selected rectangle will appear with grab handles for moving or resizing. 

When a text object is double clicked with the Selector Tool it becomes selected, but is also in
edit mode, meaning that the text inside the rectangle can be changed.    You can tell when a 
text object is in edit mode because an insertion point cursor will appear in the text, and the 
grab handles of the selected rectangle will be smaller than usual.    

When a text object is in edit mode, you can modify the text inside the text object's selected 
rectangle.    You can think of a text object in edit mode as a small text editor.    Words can be 
selected by double clicking on them, or a block of text can be selected by dragging the 
mouse pointer across the text.    All standard cut, copy and paste features work inside the 
text object.    Text can be cut, copied and pasted within a single text object or between two 
text objects, and can be copied to or pasted from other Windows programs using the 
clipboard.      For more information on using the keyboard for editing functions see the Help 
Topics Text Selection Keys, Editing Keys and Cursor Movement Keys.    

WinDraw will fit the text inside a text object to the shape of its selected rectangle as closely 
as possible.    Text will always fill up the Selected rectangle starting from the upper left 
corner, and will word wrap on word boundaries as each line of text reaches the right hand 
edge of the selected rectangle.    When no more text will fit inside the text object's selected 
rectangle, no more keystrokes will be accepted, and WinDraw will beep when a key is 
pressed.    

To make room for more text in a full text object, use the mouse to drag a grab handle, 
increasing the size of the selected rectangle.    A text object can be resized whenever it is 
selected, whether it is in edit mode or not.    WinDraw will not let you enter more text than 
will fit inside the selected rectangle, but it will let you resize the selected rectangle so that it 
is too small to show all of the previously entered text.    In this case, some text will be hidden
until the selected rectangle is made large enough to show all of the text again.    Any text 
that does not fit inside the selected rectangle will not appear in the drawing, and will not 
print.    Shrinking the selected rectangle of a text object will not remove any of the text in the
object.

Hint: When a text object is selected, the Style Font... command can be used to change the 
font or point size of the text.    If you increase the point size of the text, or change to a font 
that is larger than the previously used font, you may need to increase the size of the text 
object's selected rectangle so that all of the text is visible.    Text can be made bold, 
italicized, underlined or struck out by using the appropriate commands on the Style menu.    



Using Keystrokes to Execute Menu Commands

All WinDraw commands can be executed from the menu bar by using either mouse clicks or 
keystrokes.    To execute a command using the mouse, click on the appropriate menu name 
in the menu bar, and then click on the desired command from the menu that drops down.    

All of the items on the menu bar have one character (usually the first one) in their name 
underlined.    Also, all of the commands on the drop-down menus have one character in their 
name underlined.    As an example, notice that the S in Style is underlined on the menu bar. 
On the Style menu, the F in the Fill... command is underlined.    The underlining is a visual 
reminder of how to execute menu commands using keystrokes.    

To display a drop-down menu from the menu bar, hold down the Alt key while typing the 
underlined letter of the menu you want to use.    For example, to display the Style menu, 
hold down the Alt key and press the S key.    This is usually shown in print as Alt+S.    When 
Alt+S is pressed, the Style menu will be displayed.    To change the current fill pattern, press
the F key, since the F in Fill... is underlined on the Style menu.    Using this method, the Fill 
Color dialog box can always be accessed by pressing Alt+S and then F.        

Any command can be executed in this same fashion, by pressing Alt+menukey and then 
commandkey, where menukey is the underlined character on the menu bar, and 
commandkey is the underlined character on the drop-down menu displayed.    

Some commands on the Edit menu can be executed with single keystroke:
Command        Key Sequence  
Edit Undo Alt+Bksp
Edit Cut Shift+Del
Edit Copy Ctrl+Ins
Edit Paste Shift+Ins
Edit Clear Del
Edit Copy,
followed by
Edit Paste Ctrl+D



Drawing Lines at 45 Degree Increments

When the Line Tool is used, lines can be drawn at any angle.    If you want to draw lines that 
will always be perfectly vertical or horizontal, or at a 45 degree angle to vertical or 
horizontal, hold down the Shift key while you draw the line.    When the Shift key is held 
down while drawing a line, the line will only appear on 45 degree boundaries.    As you drag 
one end of the line around in the drawing, it will snap into different orientations that will only
allow it to be drawn as horizontal, vertical, or at a 45 degree angle.    

If an existing line is not on a 45 degree boundary and you want it to be so, select it, and then
hold down the Shift key while dragging one end of the line to the orientation that you want. 
The line will snap to a horizontal, vertical, or a 45 degree orientation.    



Drawing Squares and Circles

When the Rectangle Tool, the Rounded Rectangle Tool or the Ellipse Tool is used, rectangles 
and ellipses can be drawn with any height and width.    Geometrically, a square is one type of
a rectangle and a circle is one type of an ellipse.    When a rectangle or ellipse is drawn, 
careful placement of the mouse pointer will allow you to draw a square or a circle.    

If you want to ensure that the Rectangle Tool or the Rounded Rectangle Tool draws a true 
square, and the Ellipse Tool draws a true circle, hold down the Shift key while you use the 
Tools.    Only squares and circles (as opposed to rectangles and ellipses) can be drawn with 
the Rectangle Tool, the Rounded Rectangle Tool and the Ellipse Tool while the Shift key is 
held down.    Of course, a square drawn with the Rounded Rectangle Tool will still have 
rounded corners.    



Selecting Objects That Overlap

Objects drawn in WinDraw can overlap or cover other objects as desired.    Any number of 
objects can be stacked on top of, or overlapped with, other objects.    You can think of each 
object as being on its own sheet of paper, which can be overlapped with sheets containing 
other objects.    The order in which overlapping objects are stacked, from the lowest layer on 
the page out to the highest layer is called the vertical stacking order of the objects.    

Vertical stacking is most easily visualized when objects with solid opaque fill patterns are 
stacked on top of one another.    The first object placed will be at the bottom of the stacking 
order, and the most recently placed object will be at the top.    Only the topmost object will 
be completely visible when opaque objects are overlapped.    

You may want to select an object that overlaps or is overlapped by other objects, so that you
can move, resize or modify the object.    If you use the Selector Tool and click the mouse in a 
part of the drawing where more than one object is beneath the mouse pointer, only the 
topmost object will be selected. To select an object that is beneath the topmost object in the 
vertical stack, press the mouse button again, and an object lower in the vertical stack will be
selected.    With each press of the mouse    button, a different object in the vertical stack 
beneath the mouse pointer will become selected.    Be careful to click slowly enough to avoid
double-clicking on one of the objects, which may cause a configuration dialog box to be 
displayed.    

As an example, suppose that you want to move the middle of three objects that overlap in a 
vertical stack away from the other two.    Using the Selector Tool, move the mouse pointer to 
a point in the drawing where the three objects overlap.    When you press the mouse button 
once, the topmost object will be selected.    Release the mouse button, and press it again.    
Now the middle object of the three is selected.    Without releasing the mouse button, drag 
the selected middle object away from the other two.    

An entire set of vertically stacked objects can be selected by holding down the Shift key 
while clicking the mouse once for each object in the vertical stack. However, it will most 
likely be easier to use the Selector Tool to drag a selected rectangle around the set of 
objects.    

For more information about changing the vertical stacking order of overlapping objects see 
the Help Topic for the Layout Bring to Front, Send to Back commands on the Layout menu.    

Hint: If you don't want to deselect a selected object and select another that overlaps it, 
hold down the Ctrl key, and the selected object will remain selected when you click on it, or 
move or resize it, instead of selecting an overlapping object.    



Working With Groups of Objects

Most of the drawing operations you will perform will affect a single object.    However, if there
is a set of objects in a drawing that you want to modify all at once, you can do so by creating
a group.    For example, if you want a rectangle, an ellipse and a closed polygon to all have 
the same fill pattern, the quickest way to do this is to select all three of the objects, and use 
the Style Fill... command to alter the fill pattern of all three objects at once.    

One way to select more than one object at a time is to select the first one with the Selector 
Tool, and then hold down the Shift key while clicking on subsequent objects that you want 
to select.    Another way is to press the mouse button while using the Selector Tool, and drag 
a selected rectangle across the objects that you want to select.    When you release the 
mouse button, all objects touched by the rectangle will become selected.    The grab handles 
of the individual objects will be gray, and the group of objects will be surrounded by a 
selected rectangle that has larger than normal grab handles.    

Once you have selected all of the objects that you want to operate on as a group, you can 
move or resize all of the objects as one, or change the attributes of all of the objects, or 
perform rotations and flips on the group as a whole.    

If you click outside of the group's selected rectangle, the objects will retain their new size, 
shape, position etc. but will become separate objects again.    If you want the group of 
objects to continue to behave as a group after you deselect them, execute the Layout Group
command before you deselect them.    Thereafter, when you click on any individual object of 
the group, all of the objects in the group will again become selected.    Multiple groups can 
exist at one time.    If you want the objects in a group to revert to individual objects, select 
the group, and then execute the Layout Ungroup command.    



Copying an Object's Attributes

Objects have various attributes that help define them. Object attributes include line style, 
line thickness and line color, fill pattern and fill color, and font and point size.    Only certain 
attributes apply to a specific object.    For example, an arc has line style, line thickness and 
line color attributes, but it cannot have a fill pattern, or any text attributes such as font or 
point size.    

Only text objects can have the attributes of font, point size, bold, underline, etc.    Every 
object except text objects have line style, line thickness and line color attributes.    These 
determine how the outline of the object will be drawn.    Lines can have line ending 
attributes, which determine what kind of shape, if any, will be drawn on the ends of lines.    
Only objects that make a closed shape can have fill patterns.    These include rectangles, 
rounded rectangles, ellipses, pies, closed polygons and closed scribbles.    

All object attributes are selected from the Style menu, using the Style Fill..., Style Lines..., 
Style Endings... and Style Font... commands.    The attributes that are configured using these 
commands will be used when any new object is drawn.    The attributes configured via the 
Style menu are know as the current attributes.    When an object is selected, its attributes 
are automatically used as the current attributes.    This means that if a blue fill pattern and a 
dashed line style are configured as the current attributes, but a rectangle with a red fill 
pattern and a solid outline is selected and resized, its attributes will become the current 
attributes.    So, when a new object is drawn, it will have a red fill pattern and a solid outline.  

To make the current attributes match those of an object in a drawing, select the object with 
the Selector Tool, and its attributes will be picked up as the current attributes.    This feature 
allows you to draw a new object whose attributes match an existing object's attributes 
exactly, without having to reconfigure the current attributes.    



Converting Between Polygons and Bezier Curves

Open and closed polygons and Bezier curves are all related geometrically, and WinDraw will 
let you convert any of these three objects to any of the other types at will.    If you have 
drawn an open polygon, but want it to have a fill pattern, you can convert it to a closed 
polygon and give it a fill pattern.    Or, you may want to convert a polygon, which is made of 
straight lines, into a Bezier curve, which is a smooth curve.    

To convert among any of these three object types, double click on any of these objects with 
the Selector Tool, and the dialog box titled Polygon Type will be displayed.    Click on the 
radio button next to the polygon type that you want, and then click on the OK button.    The 
object will be converted to the type you selected.    



Using WinDraw with Paintbrush

You can share images between WinDraw and Paintbrush, the painting program that comes 
with Windows.    You may want to use some of the painting tools in Paintbrush to create a 
special effect, and then incorporate that image into a WinDraw drawing.    Or, you may want 
to change a drawing from WinDraw into a bitmap, using Paintbrush to modify the drawing, or
to save it in a standard bitmap file format.    You can cut and paste all or part of a WinDraw 
drawing into a Paintbrush drawing, and vice versa, by using the clipboard.    Refer to your 
Windows documentation for specific information about using Paintbrush.    

Moving Images from Paintbrush into WinDraw
Paintbrush allows you to create shapes such as circles and polygons, and lets you use tools 
such as the Airbrush and Paint Roller to create different textures and fill patterns.    When you
Zoom In on a region of a Paintbrush picture, you can work with great detail on a small part of
the picture.    Paintbrush can be useful for precisely drawing small images to be used within 
WinDraw.    The Paintbrush scissors tools are used to mark either a rectangular or an irregular
region of a drawing, which can then be cut or copied to the clipboard.    

Once an image from Paintbrush is on the clipboard, the WinDraw command Edit Paste can be
used to paste one or more copies of it into a WinDraw drawing or symbol.    The image within
WinDraw will be inside a rectangular region, which can be moved and resized whenever it is 
selected.    An image pasted in from Paintbrush is a single object inside WinDraw, and only 
some of its attributes can be changed.    A Paintbrush image can be grouped with other 
objects, and can be flipped vertically or horizontally, but its fill pattern and line style cannot 
be changed, and it cannot be rotated.    

Moving Images from WinDraw into Paintbrush
The method used to move images from WinDraw to Paintbrush is similar to the one 
described above.    One or more objects that are selected within a WinDraw drawing can be 
cut or copied to the clipboard using the Edit Cut or Edit Copy commands.    Those objects can
then be pasted into a Paintbrush drawing, and modified with Paintbrush tools.    You can also 
use the File Export... command to export (translate) a copy of a WinDraw drawing into a 
bitmap (.BMP) file format, which can be read directly by Paintbrush.    

It is important to understand that images in Paintbrush have different characteristics from 
those in WinDraw.    Any object that you create in a WinDraw drawing can be moved and 
modified after you have drawn it.    If you cut or copy one or more objects to the clipboard 
and then paste them back into a WinDraw drawing, the objects can continue to be modified. 
However, any objects copied from a WinDraw drawing and then pasted into a Paintbrush 
drawing will be in bitmap form.    Objects pasted from WinDraw into Paintbrush will appear 
just as they did within WinDraw, but will be a single image within Paintbrush.    Thus, they 
can no longer be treated as individual polygons, text objects, etc., but can only be modified 
with the tools provided by Paintbrush.    



Exchanging Graphics with Other Programs

WinDraw can be used as a drawing tool by itself, but it can also be used to create 
illustrations in documents produced by other Windows programs.    Moving graphical 
information between different programs has traditionally been a mysterious and sometimes 
painful process, but this will explain two straightforward procedures that will let you share 
graphics between WinDraw and other programs.    The two procedures, in order of preference
and ease of use are: 1) using the clipboard to copy graphics, and 2) exporting drawings into 
a different file format, so that they can be imported by the another program.    

Using the clipboard to exchange graphics
The Windows clipboard is a very versatile tool that can be used to copy text, numbers, 
graphics and other forms of data either within a single program or between different 
programs.    Using the clipboard to move graphics from WinDraw into other programs, and 
vice versa, is a simple way to share graphics between programs.    You can use the Edit Cut, 
Edit Copy and Edit Paste commands to exchange graphics via the clipboard.    

When copying graphics from one program to another using the clipboard, the only 
requirement is that the source program place the graphical information on the clipboard in a 
format that the receiving program can understand.    WinDraw places graphics onto the 
clipboard simultaneously in its own private format, and    in bitmap and metafile formats.    
Any program that can read either of the latter two formats can share graphics with WinDraw 
via the clipboard.    WinDraw can also import graphics from other programs via the clipboard 
when the graphics are in bitmap or Windows metafile formats.    When WinDraw brings in 
graphics from other programs, the entire contents of the clipboard will be brought into 
WinDraw as a single element, not as individual lines, curves, etc.    

Using file export and import to exchange graphics
Some Windows programs do not import graphics from the clipboard, or do not do so with 
graphics placed on the clipboard in bitmap or metafile formats.    Some of these programs 
can bring in graphics by reading the graphical data from a file on disk.    If you are using a 
program that cannot bring in graphics from the clipboard, you may be able to use WinDraw's
export capabilities to move a drawing into the other program.    The File Export... command
can translate a WinDraw drawing into a disk file that holds data in either bitmap or Windows 
metafile formats.    Bitmap file names end in .BMP, and metafile file names end in .WMF.    
When you export a drawing into one of these two new formats, other programs can import 
the graphical data from the file into their documents.    See the Help Topic File Export... 
Command for information about exporting WinDraw drawings to other file formats.    



Working With the Multiple-Document Interface

You can think of the space within the WinDraw window as a workplace, where you can work 
with many drawings and libraries at a time.    Just as with other Windows programs, you can 
let some windows overlap others, or arrange them in any fashion that makes sense to you.    
The WinDraw window is one of several windows in the Windows workplace, and each 
drawing and library window within WinDraw can be one of several windows open in the 
WinDraw workplace.    

Each drawing and library window in the WinDraw workplace can take up all of the working 
surface in WinDraw, or it can share the workplace with other windows, or it can be made into
an icon that will remain in the workplace with only a title showing.    The easiest way to 
control the size and placement of windows in the WinDraw workplace is by using the mouse 
with the window borders and the Minimize and Maximize buttons.    

When a new file is opened in WinDraw, it is drawn into a window that takes up only part of 
the workplace.    If you want to change the size or shape of a window you can do so by 
dragging the borders or the corners of the window in or out with the mouse pointer.    If you 
want to move a window in the workplace, you can drag the window when the mouse pointer 
is over the title bar of the window.    

To enlarge a window so that it uses all of the available space in the WinDraw workplace, click
on the Maximize button at the upper right hand corner of the window.    The Maximize 
button will then turn into the Restore button, and you can click on it to restore the window 
back to its original size.    If you click on the Minimize button in the upper right hand corner 
of the window, the window will be made into an icon in the workplace, where it can be 
moved or restored to a window as you wish.    None of these activities has any effect on the 
contents of drawings or libraries.    

When a window has been made into an icon, you can drag it around the workplace with the 
mouse, or click on it to expose a menu of commands.    The menu that is displayed when you
click on an icon will let you restore or maximize the window, or close it.    If you double click 
on an icon, it will be restored to its former size and position.    



HELP: GLOSSARY



Glossary

Place the mouse pointer over the item that you would like defined, and hold down the 
mouse button to see the definition.

aspect ratio
attributes
bitmap
click
clipboard
command
control point
double click
drag
drawing
drawing grid
edit mode
fill pattern
grab handle
group
insertion point cursor
library
linked
metafile
mouse pointer
object
opaque
Paste Special
properties
ruler
right mouse button
selected
selected rectangle
symbol
transparent
Tool Palette
vertical stacking order
visible grid
workplace



THIRD LEVEL OF HELP TOPICS:



FILE MENU:



File New... Command

The File New... command is used to create and open a new drawing or library file.    When 
the command is executed, a dialog box titled New File is displayed asking you to select 
either a drawing file or a library file.    Click on the radio button next to the type of file you 
would like to open, and then click on the OK button.    A drawing file can contain a single 
drawing, and will have the file name suffix .WDR.    A library file can contain a series of 
drawings that are called symbols, and that have special properties.    Library files will have 
the file name suffix .WDL.    For general purpose drawing, use a drawing file, not a library 
file.    For more information on libraries and symbols see the Help Topic Overview of Symbols 
and Libraries.

When the new drawing or library file is opened, any previously opened drawings and 
libraries will remain open, and will be unaffected.    The newly created file will be given a 
generic name, such as Drawing1 or Library2.    These are temporary names, and WinDraw 
will prompt you to rename the file when you save it for the first time.    

WinDraw allows multiple drawing and library files to be open at the same time.    WinDraw's 
Multiple-Document Interface is described in the Help Topic    Working With the Multiple-
Document Interface. To find out how to access one of the drawing or library files that are 
open within WinDraw, see the Help Topic Window List of Open Files command.



File Open... Command

The File Open... command is used to open an existing drawing or library file.    When the 
command is executed, a dialog box titled Open File is displayed, which contains a list box 
showing all the WinDraw files in the current directory, and a list of other drives and 
directories where you can look for files to open.    The name of current directory is displayed 
just below the Open File Name: field.    You can open as many drawing and library files 
within WinDraw as you like.    

If the file you want to open is displayed in the list box, you can double click on it to open it, 
or select it by clicking on it once and then clicking on the Open button.    The contents of the
list box are all the files in the current directory that end in .WDR or .WDL, which are 
WinDraw's default file suffixes for drawing and library files, respectively.    Also displayed are 
other drives and directories in the system that you can double click on to search in.    

The field labeled Open File Name: contains the specification for the files WinDraw will 
display in the list box below it.    The default file specification is *.WD*, which will show all 
files that end in .WDR and .WDL in the list box.    You can enter a file name from the current 
directory, or a file name with a full path in front of it in the Open File Name: field, and 
WinDraw will open that file when you click on the Open button.    

If you want WinDraw to search for other file types, enter a new file specification.    For 
example, if you want WinDraw to display all files that end in .DRW in the current directory, 
enter *.DRW in the Open File Name: field.    

To delete a file that is entered in the Open File Name field, or selected in the list box, click 
on the Delete button.    To cancel the File Open... command, click on the Cancel button.



File Save Command

When the File Save command is executed, the currently active drawing or library file within 
WinDraw will be saved to disk.    The drawing or library file will not be closed from the 
WinDraw workplace, and you can continue working with that file or any other that is open.    
The File Save command only saves the active drawing or library file to disk.      You must 
save each file that you have open separately, and any changes made to a drawing after the 
File Save command is executed will not be saved to disk until the File Save command is 
executed again.    

If you are saving a file for the first time, it will have a default file name such as Drawing1 or
Library2.    WinDraw will prompt you to change the name of the file with a dialog box titled 
Save File.    This dialog box shows the current directory where the file will be saved, and has
a field labeled Save File Name As: where you can enter the new name for the file.    The 
file name can include a full path name if you want to save the file in another directory.    

Any DOS file name is a valid choice for naming a drawing or library file, but we suggest that 
you use .WDR as the file name suffix for drawing files, and .WDL for library files.    This will 
ensure that WinDraw will immediately find the files you have saved previously when you use
the File Open... command.    



File Save As... Command

You can save the current drawing or library file under a new file name using the File Save 
As... command.    The original file will still exist as it was last saved under its original file 
name, but the new file that you name with the File Save As... command will be created 
and will contain the drawing or library file as it currently exists.    

When you execute the File Save As... command, WinDraw will prompt you for the new file 
name with a dialog box titled Save File.    This dialog box shows the current directory where 
the new file will be created, and has a field labeled Save File Name As: where you can 
enter the new file name.    The file name can include a full path name if you want to create 
the file in another directory.    

This command may be useful if you have created a drawing that you want to keep, but need 
to create a second drawing that is similar to the first.    You can use the File Save As... 
command to save the first drawing as the second, and continue working with the newly 
created second file.    Note that when you use the File Save As... command, the new file 
will be created, and any further changes that you make to the drawing or library will be 
made in the new file, not in the original file.    

If a file with the name that you entered in the Save File dialog box already exists, you will 
be prompted to either OK overwriting that file, or cancelling the File Save As... operation.    



File Close... Command

The File Close... command will close the currently active drawing or library file from the 
WinDraw workplace.    All other drawings and libraries in the WinDraw workplace are 
unaffected.    If changes have been made to the currently active drawing or library since you 
last saved it, you will be prompted with a dialog box asking if you want to save the file 
before closing it.    You can choose to save the file by clicking on the Yes button, or you can 
discard any changes since the file was last saved by clicking on the No button.    You can 
cancel the File Close... command by clicking on the Cancel button.    



File Export... Command

The File Export... command will export (translate) either the entire active drawing, or just 
the objects that are currently selected, into a file format other than WinDraw's standard
.WDR or .WDL file formats.    Some programs expect graphics to be in a certain file format, 
and you can use the File Export... command to move graphics from WinDraw into other 
Windows programs.    

The easiest way to move graphics from WinDraw into another program is to copy objects or 
entire drawings from WinDraw onto the clipboard, and then paste them into the other 
program.    Unfortunately, some Windows programs don't support this capability, but rather 
insist on importing graphics from a file on disk.    The File Export... command will translate 
WinDraw graphics into either bitmap (.BMP) or Windows metafile (.WMF) file formats, 
allowing you to import your WinDraw drawings into other programs that support either of 
those file formats.    It is important to note that WinDraw cannot import graphics from .BMP 
or .WMF files;    it can only read files that are in its own .WDR or .WDL formats.    

When the File Export... command is executed, a dialog box titled Export is displayed.    You
should first choose either a bitmap or a metafile file format to export your drawing into.    
Most painting programs (like Paintbrush) can read bitmap files, and many word processors 
and graphics programs can read metafile file formats.    You will need to consult the 
documentation for your specific program to determine which file format is best to use when 
importing graphics.    

The controls in the Include box let you choose whether to export the entire contents of your
drawing, or only the objects that you currently have selected in the drawing.    You can use 
the Current Selection option to export only a part of a drawing.    Beneath the Include box 
is a text entry field labeled Export File To: where you should enter a name for the export 
file.    The file name should end in .BMP or .WMF as needed.    

If you choose a bitmap file format, the controls labeled Bitmap Size will be enabled, 
allowing you to enter a size for the bitmap.    If you check the Full Screen check box, a 
bitmap as large as your display will be generated.    If you do not check the Full Screen 
check box, you must enter a width and height for the bitmap in pixels.    For example, if you 
have a standard VGA display with a resolution of 640 pixels by 480 pixels, and you want to 
generate a bitmap that fills one quarter of the screen, you can enter a width of 320 pixels, 
and a height of 240 pixels.    The initial bitmap size shown in the Width and Height boxes 
will be 0 by 0.    You must enter a width and height or choose the Full Screen option.    
WinDraw will remember the size you chose between executions of the File Export... 
command.    

Once you have specified the options that you want to use for exporting your drawing, click 
on the OK button, and the export file will be created.    Your drawing will not be affected by 
the export operation, and the drawing itself will remain in .WDR or .WDL file format.    You 
will have produced a copy of your drawing in the new file format.    

A word of caution: bitmaps can take up large amounts of memory; a full screen bitmap 
can occupy multiple megabytes.    The precise amount of memory consumed depends on the
resolution of your display, the number of simultaneous colors that your display driver 
software is configured for, and the size of the bitmap itself.    If you do not have enough 
memory to generate a large bitmap, you can free up memory by closing other programs that
are running.    Because of the method used by Windows to allocate memory, it will 
sometimes help to stop and then restart Windows before exporting a large bitmap.    

For more information on exchanging graphics with other Windows programs, see the Help 



Topic Exchanging Graphics with Other Programs.    



File Printer Setup... Command

The File Printer Setup... command will display a dialog box from Windows, which you can 
use to configure your printer before you print a drawing.    The exact contents of the dialog 
box will depend on the style of printer that you have configured in Windows, but the dialog 
box will let you configure items such as graphics resolution, paper size, draft or letter quality
mode and other printer parameters.    Click on the OK button when your printer 
configuration is correct.    



File Print Preview... Command

The File Print Preview... command will display a dialog box that shows your drawing as it 
will print on a page.    You can use this command to see the position of your drawing on the 
page, and to view the drawing as a whole.    The page display will not show some of the 
smallest details of your drawing, but the complete drawing will print just as you have drawn 
it.    In particular, if you do not have very small point size Windows fonts installed, text which 
is small in your drawing may not appear in the print preview display, but will print correctly.   

Click on the Print button to print the drawing, or on the Cancel button to close the dialog 
box without printing.    



File Print... Command

The File Print... command is used to print the currently active drawing or library symbol.    
When you execute the command, the dialog box titled Print Job Settings is displayed, 
which lets you select the number of copies to be printed, and whether to print using draft 
quality or not.    When you have made these selections, click on the OK button to print the 
drawing.    You can click on the Cancel button to halt the File Print... command.    

Hint: In some instances, parts of your drawing may appear differently when printed than 
they appear in WinDraw.    Some printers, particularly dot matrix printers, interpret printing 
commands from Windows differently than what you might like.    If you see lines that are the 
wrong thickness, or text that is the wrong size, try using the File Printer Setup... command to
change the configuration of your printer.    Look for references to Draft or Graphics modes, 
and in general, select the mode that will produce the best graphics.    In some cases, a 
printer may have several graphics resolutions, expressed (for example) as "360 by 180" or 
"180 by 180".    Some objects from WinDraw will appear most accurately if you select a 
"square" resolution, such as "180 by 180".    



File Exit... Command

The File Exit... command is used to save and close all open drawings and libraries within 
WinDraw, and to end WinDraw.    If any files are open that have been changed since the last 
time they were saved, you will be prompted with a dialog box for each changed drawing and
library asking if you want to save the changes, discard the changes, or cancel the File 
Exit... command.    



EDIT MENU:



Edit Undo Command

The Edit Undo command is used to negate the last drawing operation that was performed.   
When the Edit Undo command is executed after a drawing operation, the drawing is 
restored to its state just prior to that operation.    

Some of the commands and operations that can be reversed with the Edit Undo command 
are: 

the deletion of any object 
the creation of any new object except a text object 
the insertion or removal of a control point on a polygon or Bezier curve 
any moving or resizing of an object 
any flip or rotation of an object 
the creation of an object group 
a change in the fill pattern, line style or line endings of an object.    

You can also undo the Edit Undo command itself.    When a text object is being modified in 
edit mode, the Edit Undo command undoes text editing operations, such as cuts, copies 
and pastes.    



Edit Cut Command

The Edit Cut command is used to remove the selected object or set of objects from a 
drawing and place them on the clipboard.    Objects on the clipboard can be pasted into the 
currently active drawing, into another WinDraw drawing or library, or into another Windows 
program that supports graphical objects.    To remove an object from a drawing and place it 
on the clipboard, use the Selector Tool to select it, and execute the Edit Cut command.    

When a text object is being modified in edit mode, the Edit Cut command is used to remove
the selected text from the text object and put it on the clipboard.    



Edit Copy Command

The Edit Copy command is used to copy the selected object or set of objects from a 
drawing onto the clipboard.    Objects on the clipboard can be pasted into the currently active
drawing, into another WinDraw drawing or library, or into another Windows program that 
supports graphical objects.    To place a copy of an object on the clipboard, use the Selector 
Tool to select it, and execute the Edit Copy command.    If you want to quickly duplicate one 
or more objects, select the objects you want to copy, and press the key sequence Ctrl+D.    
This will copy the selected object(s) to the clipboard and paste them into your drawing in a 
single step.    

When a text object is being modified in edit mode, the Edit Copy command is used to copy 
the selected text from the text object onto the clipboard.    



Edit Paste Command

The Edit Paste command is used to insert the contents of the clipboard into the currently 
active drawing.    The contents of the clipboard can include any object or set of objects that 
were cut or copied from a WinDraw drawing, a bitmap from another program, or formatted 
or unformatted text from another program.    When the Edit Paste command is executed, 
the contents of the clipboard are inserted into the active drawing in the middle of the 
window, and the object is left selected.    It can be moved or resized as needed.    If you want 
to quickly duplicate one or more objects, select the objects you want to copy, and press the 
key sequence Ctrl+D.    This will copy the selected object(s) to the clipboard and paste them
into your drawing in a single step.    

When a text object is being modified in edit mode, the Edit Paste command is used to 
paste the contents of the clipboard into the text object, if the clipboard contains text.    
Graphical objects such as lines and rectangles cannot be pasted into text objects.    If the 
clipboard contains text, and the Edit Paste command is executed when no text object is in 
edit mode, a new text object will be created.    

The contents of the clipboard can be pasted into a drawing multiple times if desired.    If the 
Edit Paste command is executed, the contents of the clipboard will be pasted into the 
drawing, but will also remain on the clipboard.    The newly pasted in object should be 
deselected before pasting again, or it will be overwritten by the next paste.    



Edit Clear Command

When the Edit Clear command is executed, the selected object or objects are removed from
the active drawing, but are not placed on the clipboard.    The same function can be 
performed by pressing the Delete key while the object to be deleted is selected.    If you 
delete an object by accident, you can reverse the deletion by executing the Edit Undo 
command.    



Edit Paste Special... Command

The Edit Paste Special... command is used    to paste a symbol from a library into a 
drawing.    For a description of symbols and libraries, see the Help Topic Overview of Symbols
and Libraries. 

You can use the Prev or Next button in a library window to find the symbol that you want to
use from the library, and the Copy button to copy the symbol to the clipboard.    If you then 
make the drawing where you want to paste the symbol the active window, and execute the 
Edit Paste Special... command, a dialog box titled Paste Special is displayed.    The 
dialog box will give you three options for pasting the symbol into a drawing.    Choose either 
the Symbol (No Link), Symbol (Linked), or Separate Objects option, and click on the 
OK button to perform the paste.    If you click on the Cancel button, the paste operation will 
be cancelled.    

If you chose the Symbol (No Link) option, the symbol will be pasted into your drawing as a 
single item, as if it were a group of objects.    You can move and resize the symbol in your 
drawing as a single object, but you cannot modify the individual elements that the symbol 
comprises.    

If you chose the Symbol (Linked) option from the Paste Special dialog box, the symbol 
will again be pasted in as a single object.    In this case, however, any changes you make to 
the symbol in the original library window will automatically be reflected in every drawing 
window where the symbol has been used.    Using the Symbol (Linked) option, if you have 
used the symbol multiple times and need to change some aspect of the symbol, you need 
only make the change in the original library symbol, and every linked copy of the symbol will
be updated. 

If you chose the Separate Objects option for the Edit Paste Special... command, the 
symbol will be pasted into a drawing as individual lines, rectangles, etc.    You will be able to 
modify the individual objects that make up the copy of the symbol.    If either the Symbol 
(No Link) or the Separate Objects option was chosen during the paste, later changes 
made to the library symbol will not be reflected where the symbol has been previously used. 
The automatic updating feature is only present when using the Symbol (Linked) option.    

See the Help Topic Overview of Symbols and Libraries for complete instructions on using 
symbols and libraries.    



LAYOUT MENU:



Layout Hide/Show Ruler Command

The Layout Hide/Show Ruler command is used to hide and display the ruler in the active 
drawing.    The ruler shows the dimensions of a drawing, and the position of objects in a 
drawing, relative to the upper left corner.    The dimensions of the ruler are inches, and the 
ruler shows increments down to one sixteenth of an inch.    When the ruler is turned on, two 
thin lines that overlay the vertical and horizontal rulers show the position of the mouse 
pointer in the drawing.    

Each time the Layout Hide/Show Ruler command is executed, the ruler is toggled 
between hidden and displayed, and the text of the command shown on the Layout menu 
changes.    When a new drawing is created with the File New command, the ruler is displayed
by default, and the Layout menu will show the command Hide Ruler.    When this 
command is executed, the ruler will be hidden (turned off) in the current drawing window, 
and the Layout menu will now show the command Show Ruler.    When the Layout Show 
Ruler command is executed, the ruler will again be displayed in the current drawing 
window.    



Layout Hide/Show Visible Grid Command

The Layout Hide/Show Visible Grid command is used to hide and display the visible grid 
in the active drawing.    The visible grid appears as a pattern of dots spaced at 1/4 inch 
intervals in the drawing window.    The visible grid is useful for drawing objects with precise 
size and alignment.    

Each time the Layout Hide/Show Visible Grid command is executed, the visible grid is 
toggled between hidden and displayed, and the text of the command shown on the Layout 
menu changes.    When a new drawing is created with the File New command, the visible grid
is displayed by default, and the Layout menu will show the command Hide Visible Grid.    
When this command is executed, the visible grid will be hidden (turned off) in the current 
drawing window, and the Layout menu will now show the command Show Visible Grid.    
When the Layout Show Visible Grid command is executed, the visible grid will again be 
displayed in the current drawing window.    

The visible grid can be displayed and hidden independently from the drawing grid.    The 
visible grid is only a visual reference for your work.    The drawing grid is always invisible, but
is aligned with the visible grid.    When the drawing grid is enabled, it constrains objects to be
placed on one sixteenth inch boundaries.    If desired, the visible grid can be displayed while 
the drawing grid is disabled, or vice versa.    



Layout Drawing Grid Command

The Layout Drawing Grid command is used to turn the drawing grid on and off in a 
drawing.    When the drawing grid is turned on, objects that are drawn, moved or resized will 
be placed in the drawing on one sixteenth of an inch increments.    Working in drawings with 
the drawing grid turned on facilitates creating objects in even sizes, and aligning objects 
with other objects, or with the edge of the page.    When the drawing grid is turned on, the 
grid increments match the one sixteenth inch marks shown on the ruler.    

Each time the Layout Drawing Grid command is executed, the drawing grid is toggled 
between being enabled and disabled.    When a new drawing is created with the File New 
command, the drawing grid is on (enabled) by default, and a check mark will appear on the 
Layout menu to the left of the Drawing Grid command name.    When the Layout 
Drawing Grid command is executed, the drawing grid will be turned off, and no check mark
will appear by the command name on the Layout menu.    Executing the Layout Drawing 
Grid command again will re-enable the drawing grid, and the check mark will reappear on 
the Layout menu.    

The drawing grid can be enabled and disabled independently from the visible grid.    The 
drawing grid is always invisible, but is aligned with the visible grid.    The visible grid is only a
visual reference for your work.    If desired, the visible grid can be displayed while the 
drawing grid is disabled, or vice versa.    

Note: Thin lines that are drawn or moved while the drawing grid is disabled may be difficult 
to select when the grid is re-enabled.    To select an off grid line when the drawing grid is 
enabled, either drag the Selector Tool across the body of the line, or disable the drawing grid
and then select the line.    



Layout Bring to Front, Send to Back Commands

The Layout Bring to Front and Layout Send to Back commands are used to alter the 
vertical stacking order of overlapping objects.    Objects can be drawn or placed in a drawing 
so that they overlap or cover any number of other objects.    The order in which overlapping 
objects are stacked, from the lowest layer on the page, which is at the bottom of the 
stacking order, out to the highest layer is called the vertical stacking order of the objects.    
When opaque objects overlap, only the topmost object will be completely visible.    

You may want to change the order in which overlapping objects are stacked, since objects 
lower in the stacking order will not be visible if covered by opaque objects above them.    For 
example, you might draw a text object as a label for a rectangle, and then draw the 
rectangle with a solid fill pattern.    When you move the text on top of the rectangle, you will 
find that the rectangle hides the text.    Since you drew the rectangle later, it was given a 
higher position in the vertical stacking order.    To expose the text object, select the 
rectangle with the Selector Tool, and execute the Layout Send to Back command.    This 
will put the rectangle below the text object in the vertical stacking order, so that the text will
be drawn above it.    

When objects overlap, they are drawn one after the other, in the order of their vertical 
stacking.    The objects at the bottom of the order are drawn first, and the topmost objects 
are drawn last.    The Layout Bring to Front command has the effect of moving any 
selected object to the top of the vertical stacking order, and Layout Send to Back 
command moves a selected object to the bottom of the vertical stacking order.    

To select an object that is overlapped by other objects, use the Selector Tool and press the 
mouse button over the object.    After the first press, the topmost object will be selected, and
with each press of the mouse button, an object lower in the vertical stack will be selected.    
Be careful to click slowly enough to avoid double-clicking on one of the objects, which may 
cause a configuration dialog box to be displayed.    Remember that if you select the object 
that you want, and then release the mouse button, the next press of the mouse button will 
select another object.    This action can be suppressed by holding down the Ctrl key while 
you press the mouse button, which will cause the currently selected object to remain 
selected, instead of selecting another object in the vertical stack.    



Layout Rotate Left, Rotate Right Commands

The Layout Rotate Left and Layout Rotate Right commands are used to rotate an object
or set of objects by 90 degrees.    If the Layout Rotate Left command is executed when an 
object is selected, it will be rotated counter clockwise about its geometric center by 90 
degrees.    Any object that is selected can be rotated clockwise or counter-clockwise by 
executing the Layout Rotate Right and Layout Rotate Left commands, respectively.    

If more than one object is selected, the group is treated as a whole, and rotated about its 
geometric center.    Note that when a text object is rotated, the text itself will not rotate, 
rather the selected rectangle that defines the text object rotates.    The text will always 
appear in standard left to right and top to bottom fashion, and will be reformatted to fit into 
the new rectangle.    

Bitmaps that have been pasted into a WinDraw drawing from programs such as Paintbrush 
cannot be rotated.    For more information on working with bitmaps, see the Help Topic Using 
WinDraw with Paintbrush.    



Layout Flip Horizontal, Flip Vertical Commands

The Layout Flip Horizontal and Layout Flip Vertical commands are used to change an 
object into its mirror image, as if it were folded across its horizontal or vertical centerline.    If
the Layout Flip Horizontal command is executed when an object is selected, any features 
that were on the left side of the object will now be on the right side.    The Layout Flip 
Vertical command will mirror a selected object across its horizontal centerline, so that 
features on the bottom will afterward be on the top.    

If more than one object is selected, the group is treated as a whole, and flipped about the 
group's geometric centerline.    Note that when a text object is flipped, the text itself will not 
be mirrored, rather the selected rectangle that defines the text object is flipped.    The text 
will    always appear in standard left to right and top to bottom fashion, and will be 
reformatted to fit into the new rectangle.    



Layout Group, Ungroup Commands

The Layout Group command is used to gather a set of objects into a group, which can then 
be treated as a single object.    The group will persist until the Layout Ungroup command is
executed.    While most of the drawing operations you will perform with WinDraw will only 
involve a single object, you may want to perform some operations on more than one object.  
If there are several objects that all need the same fill pattern, or a portion of a drawing that 
you need to move as a single piece, creating a group will speed your work.    

First, select all the objects you want in the group.    Use the Selector Tool to select the first 
object, and hold down the Shift key while you click on the other objects.    When more than 
one object is selected, a selected rectangle with larger than normal grab handles will 
surround the group of objects.      When all of the objects are selected, execute the Layout 
Group command.    You can now move, resize or reconfigure all of the objects as if they were
a single object.    If you click on any of the items with the Selector Tool, the entire group will 
become selected.    To change the group back into separate objects, select the group and 
execute the Layout Ungroup command.    



STYLE MENU:



Style Fill... Command

When the Style Fill... command is executed, a dialog box titled Fill Color is displayed so 
that you can configure the current fill pattern and fill color attributes.    The dialog box allows 
you to make objects transparent or opaque, and to select a fill pattern and fill color for 
opaque objects. If the Transparent option is selected when the Fill Color dialog box is 
displayed, you will not be able to choose a fill pattern or color.    To configure a fill pattern 
and color, select the Opaque option, and the fill pattern and color controls will be enabled.    
When WinDraw is first started transparent objects are configured as a default.    

The controls labeled Hatches will allow you to choose a solid fill pattern, or one of six 
hatched fill patterns.    The Red, Green and Blue color slider controls can be moved to 
produce any composite color for the fill pattern that you want.    The numbers above the 
color sliders display the amount that each of the three individual colors contributes to the 
composite color.    The numbers range from 0 to 255, where 0 means that no amount of that 
color is present in the composite color, and 255 means that the individual color is present in 
its full strength in the composite color.      When the fill pattern configuration is correct, click 
on the OK button, or click on the Cancel button to cancel the configuration.    Whenever an 
object that can have a fill pattern is selected (including transparent objects), its fill pattern 
attributes will be adopted as the current fill attributes.    This facilitates drawing new objects 
whose fill patterns match the fill pattern of an existing object, except a closed polygon.    
Double clicking on a closed polygon displays a dialog box that allows you to change the 
closed polygon into an open polygon or a Bezier curve.    

Only objects that make a closed shape, such as rectangles, pies and closed polygons can 
have a fill pattern.    If no objects are selected when you execute the Style Fill... command, 
the current fill attributes will be configured, but no existing objects will be changed.    Objects
drawn in the future will have the new fill attributes.    Any objects that are selected when the 
Style Fill... command is executed will have their fill pattern changed to match those 
entered in the Fill Color dialog box.    The Fill Color dialog box can also be accessed 
directly by double clicking with the Selector Tool on any object that can have a fill pattern.

Hint: If you configure the color slider controls for an opaque object such that red, green and 
blue are at full strength, the color configured will be pure white.    A pure white object will 
have no color inside of it, just like a transparent object.    However, while objects that are 
beneath a transparent object will show through it, objects that are beneath an opaque white 
object will be covered by the white object.    A quick test to tell the difference between the 
two is that the visible grid will show through a transparent object, but will not show 
through an opaque white object.    



Style Lines... Command

When the Style Lines... command is executed, a dialog box titled Line Style is displayed 
so that you can configure the current line style, line color and line thickness attributes used 
to draw objects.    All WinDraw objects except text objects have line style, line color and line 
thickness attributes.    

If no objects are selected when you execute the Style Lines... command, the current line 
attributes will be configured, but no existing objects will be changed.    Objects drawn in the 
future will have the new line attributes.    Any objects that are selected when the Style 
Lines... command is executed will have their line attributes changed to match those 
entered in the Line Style dialog box.    

The Red, Green and Blue color slider controls can be moved to produce any composite 
color for lines that you want, and one of five line styles can be selected from the Style 
section.    The numbers above the color sliders display the amount that each of the three 
individual colors contributes to the composite color.    The numbers range from 0 to 255, 
where 0 means that no amount of that color is present in the composite color, and 255 
means that the individual color is present in its full strength in the composite color.      

The Width control can be moved to vary the line thickness attribute.      The number above 
the Width slider displays the relative thickness of the line style being configured.    The 
number displayed ranges from 1 to 360, where 1 represents the thinnest line possible, and 
360 represents the thickest line possible.      

When WinDraw is first started, thin, solid black lines are configured as a default.    When the 
line style configuration is correct, click on the OK button, or click on the Cancel button to 
cancel the configuration.    Whenever an object other than a text object is selected, its line 
attributes will be adopted as the current line attributes.    This facilitates drawing new objects
whose line attributes match those of an existing object.    



Style Endings... Command

When the Style Endings... command is executed, a dialog box titled Line Endings is 
displayed so that you can configure the line ending shape attributes used to draw lines.    
Only line objects have line ending attributes.    

If no lines are selected when you execute the Style Endings... command, the current line 
ending attributes will be configured, but no existing lines will be changed.    Lines drawn in 
the future will have the new line ending attributes.    Any lines that are selected when the 
Style Endings... command is executed will have their line ending attributes changed to 
match those chosen in the Line Endings dialog box.    

One of eight line ending shapes can be selected, or lines without any line endings can be 
selected.    When WinDraw is first started, lines without endings are configured as a default.   
Most line ending shapes, such as circular, square and triangular endings, have fixed 
orientations.    They will appear the same regardless of the orientation of the line.    If the 
single arrowhead or double arrowhead line endings are selected, the arrowheads will rotate 
along with the line as the line is repositioned.    All line endings will change size and color to 
match the thickness and color of the line to which they are attached.    

When the line ending configuration is correct, click on the OK button, or click on the Cancel 
button to cancel the configuration.    The Line Endings dialog box can also be accessed 
directly by double clicking with the Selector Tool on any line.

Whenever a line object is selected, its line ending attributes will be adopted as the current 
line ending attributes.    This facilitates drawing new lines whose line ending attributes match
those of an existing line.    



Style Font... Command

When the Style Font... command is executed, a dialog box titled Set Font is displayed so 
that you can configure the current font and point size attributes for text objects.    The dialog 
box allows you to select any font that is installed on your Windows system, and to select a 
standard point size or enter a specific point size.    

Only text objects have font and point size attributes.    If no text objects are selected when 
you execute the Style Font... command, the current font and point size attributes will be 
configured, but no existing text objects will be changed.    Text objects drawn in the future 
will have the new font and point size attributes.    Any text objects that are selected when 
the Style Font... command is executed will have their font and point size changed to match
those entered in the Set Font dialog box.    

All available fonts are shown in a list box labeled Typeface Name: within the Set Font 
dialog box. You can select a font by clicking on it with the mouse, which will highlight your 
selection.    Available point sizes for the font you have selected will be shown in the list box 
labeled Point Size:.    You can click on a point size in the list box to select it, or enter a point 
size directly in the text entry field just above the list box.    When the font and point size 
configuration is correct, click on the OK button, or click on the Cancel button to cancel the 
configuration. 

Whenever a text object is selected, its font and point size attributes will be adopted as the 
current font and point size attributes.    This facilitates drawing new text objects whose font 
and point size attributes match those of an existing text object.    



Style Character Format Commands

Character formatting of text objects beyond font and point size is selected directly from the 
Style menu, without the use of a configuration dialog box.    At the bottom of the Style 
menu are selections labeled Plain, Bold, Italic, Underline and Strikeout.    These menu 
items can be selected to toggle each of the text object character formats on and off as 
desired.    When a character format is enabled, a check mark will appear to its left on the 
Style menu.    Clicking on a format when it is enabled (when a check mark appears to its 
left) will turn that character formatting off.    Any combination of the Bold, Italic, Underline 
and Strikeout formats can be configured for text objects.    If the Plain attribute is selected,
all Bold, Italic, Underline and Strikeout formatting is turned off.    

If no text objects are selected when you configure new character formatting, the current 
character formatting will be configured, but no existing text objects will be changed.    Text 
objects drawn in the future will have the new character formatting.    Any text objects that 
are selected when the character formatting is changed will have their format changed to 
match the format selected from the Style menu.    



WINDOW MENU:



Window Tile Command

When the Window Tile command is executed, all drawing and library windows that are 
open in the WinDraw workplace will be moved and resized so that they share the space in 
the workplace equally without overlapping.    Drawings and libraries that have been made 
into icons will not be moved or changed back into windows.    The contents of drawings and 
libraries are not affected by this command.    



Window Cascade Command

When the Window Cascade command is executed, all drawing and library windows that are
open in the WinDraw workplace will be moved and resized so that they largely overlap one 
another, with only their title bars exposed on all but the topmost window, which will be the 
active window.    Drawings and libraries that have been made into icons will not be moved or 
changed back into windows.    The contents of drawings and libraries are not affected by this 
command.    



Window Arrange Icons Command

When the Window Arrange Icons command is executed, all drawing and library windows 
that have been made into icons will be rearranged.    The icons will be placed in rows at the 
bottom of the WinDraw workplace.    The Window Arrange Icons command is useful for 
cleaning up the appearance of the WinDraw workplace when it contains several file icons.    
The contents of drawings and libraries are not affected by this command.    



Window Close All Command

When the    Window Close All command is executed, all drawing or library files in the 
WinDraw workplace will be closed, including those that have been made into icons.    The 
Window Close All command does not end WinDraw, but will leave the workplace empty.    If
changes have been made to any of the drawing or library files since you last saved it, you 
will be prompted with a dialog box asking if you want to save the file before closing it.    You 
can choose to save the file by clicking on the Yes button, or to discard any changes since 
the file was last saved by clicking on the No button.    You can cancel the Window Close All 
command by clicking on the Cancel button.    



Window List of Open Files Command

The bottom of the Window menu contains a variable length list of all drawing and library 
files that are open in the WinDraw workplace.    Every file that has been opened is listed, 
including those that have been made into icons, and a check mark is placed beside the 
currently active window.    If you select the name of a file from the list on the Window menu,
it will be made the active window.    If the file selected is in icon form, it will be restored to a 
window and then made active.    





Windows Keys

The Help Topics below describe the use of the keyboard to perform various functions within 
Windows.    

Click on a topic for more information:

Cursor Movement Keys
Dialog Box Keys
Editing Keys
Help Keys
Menu Keys
System Keys
Text Selection Keys
Window Keys



Cursor Movement Keys

Key(s) Function

DIRECTION key Moves the cursor left, right, up, or down in a field.
End or Ctrl+Right Arrow Moves to the end of a field.
Home or CTRL+Left ArrowMoves to the beginning of a field.
PAGE UP or PAGE DOWN Moves up or down in a field, one screen at a time.



Dialog Box Keys

Key(s) Function

TAB Moves from field to field (left to right and top to bottom).
SHIFT+TAB Moves from field to field in reverse order.
ALT+letter Moves to the option or group whose underlined letter matches 

the one you type.
DIRECTION key Moves from option to option within a group of options.
ENTER Executes a command button.

Or, chooses the selected item in a list box and executes the 
command.

ESC Closes a dialog box without completing the command. (Same as
Cancel)

ALT+DOWN ARROW Opens a drop-down list box.
ALT+UP or DOWN ARROW Selects item in a drop-down list box.
SPACEBAR Cancels a selection in a list box.

Selects or clears a check box.
CTRL+SLASH Selects all the items in a list box.
CTRL+BACKSLASH Cancels all selections except the current selection.
SHIFT+ DIRECTION key Extends selection in a text box.
SHIFT+ HOME Extends selection to first character in a text box.
SHIFT+ END Extends selection to last character in a text box



Editing Keys

Key(s) Function

Backspace Deletes the character to the left of the cursor.
Or, deletes selected text.

Delete Deletes the character to the right of the cursor.
Or, deletes selected text.



Help Keys

Key(s) Function

F1 Gets Help and displays the Help Index for the application. If the 
Help window is already open, pressing F1 displays the "Using 
Windows Help" topics.
In some Windows applications, pressing F1 displays a Help topic
on the selected command, dialog box option, or system 
message.



Menu Keys

Key(s) Function

Alt Selects the first menu on the menu bar.
Letter key Chooses the menu, or menu item, whose underlined letter 

matches the one you type.
Alt+letter key Pulls down the menu whose underlined letter matches the one 

you type.
LEFT or RIGHT ARROW Moves among menus.
UP or DOWN ARROW Moves among menu items.
Enter Chooses the selected menu item.



System Keys
The following keys can be used from any window, regardless of the application you are 
using.

Key(s) Function

Ctrl+Esc Switches to the Task List.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+PrtSc Copies the entire screen to Clipboard.
Ctrl+F4 Closes the active window.
F1 Gets Help and displays the Help Index for the application. (See 

Help Keys)



Text Selection Keys

Key(s) Function

SHIFT+LEFT or RIGHT ARROW Selects text one character at a time to the left 
or right.

SHIFT+DOWN or UP Selects one line of text up or down.
SHIFT+END Selects text to the end of the line.
SHIFT+HOME Selects text to the beginning of the line.
SHIFT+PAGE DOWN Selects text down one window.

Or, cancels the selection if the next window is 
already selected.

SHIFT+PAGE UP Selects text up one window.
Or, cancels the selection if the previous 
window is already selected.

CTRL+SHIFT+LEFT or RIGHT ARROW Selects text to the next or previous word.
CTRL+SHIFT+UP or DOWN ARROW Selects text to the beginning (UP ARROW) or 

end (DOWN ARROW) of the paragraph.
CTRL+SHIFT+END Selects text to the end of the document.
CTRL+SHIFT+HOME Selects text to the beginning of the document.



Window Keys

Key(s) Function

ALT+SPACEBAR Opens the Control menu for an application window.
ALT+Hyphen Opens the Control menu for a document window.
Alt+F4 Closes a window.
Alt+Esc Switches to the next application window or minimized icon, 

including full-screen programs.
Alt+TAB Switches to the next application window, restoring applications 

that are running as icons.
Alt+ENTER Switches a non-Windows application between running in a 

window and running full screen.
DIRECTION key Moves a window when you have chosen Move from the Control 

menu.
Or, changes the size of a window when you have chosen Size 
from the Control menu.





aspect ratio

An object's aspect ratio is the relationship of its height to its width.    A square has an aspect 
ratio of 1 to 1.



attributes

Different objects have various attributes, such as a font for text objects, line ending shapes 
for lines, and line thickness, fill pattern and color for closed shapes.    



bitmap

A bitmap is a picture consisting of many individually colored dots, or pixels.    The program 
Paintbrush can be used to modify pictures that are in bitmap form.    Standard file name 
extensions for bitmap files are .BMP and .PCX.    



click

A click with the mouse is a press and release of the left mouse button.    To click on an object,
choose the Selector Tool and move the mouse pointer over the object, then press and 
release the left mouse button.



clipboard

A temporary storage area used to transfer text or graphical information within WinDraw or 
between WinDraw and another Windows program.



command

A WinDraw command is executed by accessing it through the menu bar at the top of the 
WinDraw window, or with a direct keystroke sequence.    For example, the Layout Send to 
Back command can be accessed with the mouse through the Layout menu, or with the 
keystroke sequence Alt+L and then B. 



control point

A control point is a black square that appears on certain objects when they are selected.    
Control points are slightly smaller than grab handles.    Arcs and pies have control points at 
the end of radius lines, which are used to change the degree of the arc or pie.    Polygons and
Bezier curves have control points that define the individual line segments of those objects.    



double click

To double click on an object, choose the Selector Tool and move the mouse pointer over the 
object, then press and release the mouse button twice in rapid succession.    The time 
between the clicks of a double click can be changed within Windows in the Mouse section of 
the Control Panel.



drag

To drag an object, choose the Selector Tool and move the mouse pointer over the object, 
then press and hold the mouse button.    Move the object to its new position while you hold 
down the mouse button, and then release the mouse button.    



drawing

A drawing is a window in the WinDraw workplace that contains graphical objects.    Tools from
the Tool Palette are used to create and modify objects within the drawing.    



drawing grid

The drawing grid in a drawing is turned on and off with the Layout Drawing Grid 
command.    When the drawing grid is turned on, objects that are drawn, moved or resized 
will land on one sixteenth of an inch boundaries.    The drawing grid can be enabled 
independently of the visible grid.    



edit mode

A text object is placed in edit mode by double clicking on it, thus allowing text within it to be 
entered or modified.    When a text object is in edit mode, a text insertion cursor is present 
inside the text object.    



export

When a drawing is exported, a copy of it is translated into a file format that is different from 
WinDraw's normal format.    You can use the File Export... command to make a copy of a 
WinDraw drawing in either a bitmap or a Windows metafile file format.    Other Windows 
programs may prefer to use one of the exported file formats.    



fill pattern

Objects that make a closed shape, such as rectangles, pies and closed polygons can have fill
patterns.    Fill patterns can be a striped or solid pattern, in a variety of colors.    



grab handle

Grab handles are solid black squares that appear on the selected rectangle of an object 
when it is selected.    Grab handles are used to change the size and shape of an object by 
dragging them into the desired position.    



group

When individual objects are made into a group, they can be treated as a single object and 
moved or resized as a single unit.    To create a group, select all of the objects that you want 
to group together, and execute the Layout Group command.



insertion point cursor

The insertion point cursor is a single vertical bar that appears inside a text object when it is 
in edit mode.    The cursor marks the point within the text where new characters will be 
inserted if typed.    A text object can be placed in edit mode by double clicking on it.    



import

 Other Windows programs can import graphics from WinDraw into their own documents.    
When a program imports graphics, it reads a file from disk, and translates it into its own 
graphical format.    WinDraw can export drawings into bitmap and Windows metafile file 
formats, so they can be imported into other programs.    



library

A library is a window in the WinDraw workplace that contains one or more symbols.    Tools 
from the Tool Palette are used to create and modify objects within a symbol.    A symbol can 
be copied into a drawing in a variety of methods.



linked

When a library symbol is pasted into a drawing as a linked symbol, changes that are made 
to the symbol in its library are reflected automatically in every use of the symbol in 
drawings.    



metafile

A metafile contains a series of instructions in a common format, which lets two different 
programs share information.    WinDraw can exchange a metafile between itself and another 
program using the clipboard.    The metafile describes the appearance of graphical images 
within WinDraw or the other program, and is used to share images between WinDraw and 
the other program.    



mouse pointer

The mouse pointer is used to click or drag objects in a drawing.    It is usually shaped like an 
arrow. 



object

An object is any graphical element in a drawing, such as a line, ellipse or Bezier curve.    
Another object type is the text object.    



opaque

Objects that make a closed shape can be opaque or transparent.    If the opaque option is 
selected in the Fill Colors dialog box, a fill pattern can be selected. 



Paste Special

The Edit Paste Special... command is used to paste a symbol from a library into a drawing.
Using the Edit Paste Special... command, a symbol can be pasted using the Linked, No 
Link or Separate Objects options.



properties

Properties are textual descriptions of a symbol.    You can view and modify a symbol's 
properties by clicking on the Prop... button in a library window.    You can locate a symbol in 
a library by searching for its properties.    Click on the Search... button in a library window to
search for a symbol.    



right mouse button

The right mouse button is the rightmost button on the mouse, whether the mouse has two 
buttons or three.    The middle mouse button on a three button mouse serves no purpose in 
WinDraw.    



ruler

The ruler is the graphical indicator of the dimensions in a drawing.    The ruler is turned on 
and off with the Layout Hide/Show Ruler command.    When the ruler is turned on, a 
vertical and a horizontal line appear which show the position of the mouse pointer in the 
drawing.



selected

An object is selected by clicking on it with the Selector Tool.    When an object is selected, it 
is surrounded by a selected rectangle,  and it can be moved and resized or have its 
attributes changed.



selected rectangle

The selected rectangle appears around an object when it is selected:     The selected 
rectangle is composed of eight grab handles which can be used to resize the object.



symbol

A symbol is created within a library using Tools from the Tool Palette.    A symbol can be 
pasted into one or more drawings with one of several options.    If the linked option is used 
when pasting a symbol, any change made to the symbol in the library is later reflected in 
every drawing where it is used. 



transparent

Objects that make a closed shape can have fill patterns or can be transparent.    If the 
transparent option is selected in the Fill Colors dialog box, no fill pattern will be used, and 
objects beneath a transparent object can be seen beneath the transparent object.      



Tool Palette

The Tool Palette is the column of icons at the left of the WinDraw workplace.    A drawing tool 
can be selected from the Tool Palette by clicking on it.    



vertical stacking order

When objects are drawn or moved such that they overlap one another, the order in which 
they are stacked from the lowest layer on the page to the topmost layer is called the vertical
stacking order.    An object's position in the vertical stacking order can be changed with the 
Layout Bring to Front and Layout Send to Back commands.



visible grid

The visible grid in a drawing is displayed and hidden with the Layout Hide/Show Visible 
Grid command.    When the visible grid is turned on, a pattern of dots will appear at 1/4 inch 
intervals on the surface of a drawing.    The visible grid can be displayed independently of 
the drawing grid.    



workplace

The WinDraw workplace is the space that is available inside the WinDraw program window.    
Multiple drawing and library windows may be open in the workplace, and windows may be 
present in icon form in the workplace.    




